
Esov Software User Manual i

Esov Software User Manual

PE-SW-ESA-GS-154 2.6.4

17 Nov 2020

Copyright © 2008 - 2020 ESA



Esov Software User Manual ii

Copyright © 2008 - 2020 ESA

Esov, Esov NG, ESA and the ESA logo are trademarks of the European Space Agency. Java is a trademark of Sun Microsystems,
Inc. JIDE is a trademark of JIDE Software, Inc. All other trademarks are acknowledged as the property of their respective owners.

Copyright 2006 - 2020 by the European Space Agency. All Rights Reserved. This document is subject to copyright protection.
No portion may be copied without prior written consent from the European Space Agency.

Esov utilises the JIDE Docking Framework Technology which is copyright of JIDE Software, Inc.

Copyright © 2008 - 2020 ESA



Esov Software User Manual iii

COLLABORATORS

TITLE : REFERENCE :

Esov Software User Manual PE-SW-ESA-GS-154
2.6.4

ACTION NAME DATE SIGNATURE

WRITTEN BY Sergio Saraiva 17 Nov 2020

REVISION HISTORY

NUMBER DATE DESCRIPTION NAME

2.6.4 17/11/20 Esov 2.6.4, Updates from Evolutive Maintenance
Actions (CCN#14)

S. Saraiva, E. Lopes,
B. Peña

2.6.2 15/09/20 Esov 2.6.2, Updates from Evolutive Maintenance
Actions (CCN#11)

S. Saraiva, E. Lopes,
B. Peña

2.5.3 24/05/19 Esov 2.5.3, Updates from Evolutive Maintenance
Actions (CCN#8)

J. Oliveira, E. Lopes

2.5.2 31/10/18 Esov 2.5.2, Updates from Evolutive Maintenance
Actions (CCN#8)

J. Oliveira, E. Lopes

2.5 26/09/18 Esov 2.5, Update and corrections related to final
delivery of Esov v2.5.0

J. Oliveira, E. Lopes

2.4 11/12/16 Esov 2.4, Updates from Evolutive Maintenance
Actions (CCN#5)

R. Mestre

2.3 11/12/15 Esov 2.3, Updates from Evolutive Maintenance
Actions (CCN#3)

R. Mestre

2.2 20/04/15 Esov 2.2, Updates from Evolutive Maintenance
Actions.

R. Mestre

2.1 30/05/14 Esov 2.1, Updates from Corrective Maintenance
Actions.

R. Mestre

Copyright © 2008 - 2020 ESA



Esov Software User Manual iv

REVISION HISTORY

NUMBER DATE DESCRIPTION NAME

2.0 19/11/10 Minor corrections, version adjusted to snapshot
version (Esov 2.0).

O. Danne

1.7 05/11/10 Updates and corrections related to snapshot
delivery of Esov 2.0 from 05 Nov 2010.

O. Danne

1.6 17/12/09 Updates and corrections related to delivery of
Esov 1.6.1.

O. Kock

1.4 28/05/09 Updates and corrections related to delivery of
Esov 1.5.

O. Danne

1.3 24/10/08 Updates and corrections related to Esov 1.1. O. Danne

1.2 18/04/08 Minor updates and corrections. O. Danne

1.1 28/02/08 Minor updates and corrections after Esov FAT. O. Danne

1.0 31/01/08 Initial release. O. Danne

Copyright © 2008 - 2020 ESA



Esov Software User Manual v

Contents

1 Introduction 1

1.1 Scope . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 1

1.2 Acronyms and Nomenclature . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 1

1.2.1 Acronyms . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 1

1.2.2 Nomenclature . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2

1.3 Applicable Documents . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2

1.4 Reference Documents . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2

2 Software Installation 3

2.1 Usage Requirements . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3

2.1.1 General Requirements . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3

2.1.2 Windows 7/8/10 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3

2.1.3 Mac OS X . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3

2.1.4 Linux . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 4

2.2 How to get the Software . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 4

2.3 Esov Installation / Uninstall Process . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 4

2.3.1 Windows 7/8/10 Installation . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 4

2.3.2 Mac OS X Installation . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 4

2.3.3 Linux Installation . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 4

2.4 Uninstalling the Installed Software . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 4

2.4.1 Windows 7/8/10 Uninstall . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 4

2.4.2 Mac OS X Uninstall . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 5

2.4.3 Linux Uninstall . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 5

2.5 Overview of Files and Folder Structure . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 5

2.5.1 Installation Directory . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 5

2.5.2 Application Directory . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 6

2.5.3 Esov data file types . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 6

2.5.3.1 Scenario Files . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 6

2.5.3.2 Satellite Identification Files . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 7

2.5.3.3 Swath Control Files . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 7

Copyright © 2008 - 2020 ESA



Esov Software User Manual vi

2.5.3.4 Swath Definition Files . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 7

2.5.3.5 Orbit Scenario Files . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 7

2.5.3.6 Predicted/Restituted Orbit Files (POF/ROF) . . . . . . . . . . . . . . . . . . . . . . . . . . . 7

2.5.3.7 Zone Database Files . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 7

2.5.3.8 Station Database Files . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 7

2.5.3.9 Zone List Files . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 7

2.5.3.10 Station List Files . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 8

2.5.3.11 LLF Files . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 8

2.5.3.12 UTF Files . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 8

2.6 Getting Further Information . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 8

3 Starting Esov 9

3.1 Windows XP, Vista, 7, 8, 10 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 9

3.1.1 Starting the Esov executable . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 9

3.2 Mac OS X . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 9

3.2.1 Starting the Esov application . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 9

3.3 Linux . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 9

3.3.1 Starting the Esov application . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 9

4 Basic Concepts 10

4.1 Scenario . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 10

4.2 User Interface Overview . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 10

4.2.1 Main Window . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 10

4.2.2 Menus . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 11

4.2.2.1 File Menu . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 11

4.2.2.2 Edit Menu . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 13

4.2.2.3 Tools Menu . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 13

4.2.2.4 Window Menu . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 14

4.2.2.5 Help Menu . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 16

4.2.3 Main Toolbar . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 16

4.2.4 Toolwindows . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 18

4.2.5 Maps . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 18

4.2.6 Layers . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 19

5 Scenarios 20

5.1 Creating a New Scenario . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 20

5.2 Changing a Scenario . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 21

5.2.1 Orbit Toolwindow . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 21

5.2.1.1 Toolbar Elements . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 21

5.2.1.2 Orbit Panel (’Use orbit parameters’ input mode) . . . . . . . . . . . . . . . . . . . . . . . . . 21

Copyright © 2008 - 2020 ESA



Esov Software User Manual vii

5.2.1.3 OSF Selection . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 22

5.2.1.4 OSF File Selection Panel . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 22

5.2.1.5 OSF Orbit Settings Panel . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 23

5.2.1.6 POF/ROF Selection . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 23

5.2.1.7 POF/ROF File Selection Panel . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 23

5.2.1.8 TLE Selection . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 23

5.2.1.9 TLE File Selection Panel . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 23

5.2.1.10 Info Panel . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 23

5.2.1.11 Graphical Settings Panel . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 23

5.2.1.12 Orbit Validation . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 24

5.2.2 Instruments Toolwindow . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 26

5.2.2.1 Toolbar Elements . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 26

5.2.2.2 SCF File Selection . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 26

5.2.2.3 Instrument Scope Selection . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 26

5.2.2.4 Apply SZA . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 27

5.2.3 Zones Toolwindow . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 27

5.2.3.1 Toolbar Elements . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 27

5.2.3.2 Zone List . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 28

5.2.4 ’Add Zones’ Dialog . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 28

5.2.4.1 Toolbar Elements . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 28

5.2.4.2 Zone List . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 29

5.2.4.3 Buttons . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 29

5.2.5 Stations Toolwindow . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 29

5.2.5.1 Toolbar Elements . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 30

5.2.5.2 Station List . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 30

5.2.6 ’Add Stations’ Dialog . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 31

5.2.6.1 Toolbar Elements . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 31

5.2.6.2 Station List . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 31

5.2.6.3 Buttons . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 32

5.2.7 Sub-Satellite Point Toolwindow . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 32

5.2.7.1 Toolbar Elements . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 32

5.2.7.2 SSP Selection . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 32

5.2.7.3 SSP Time Selection . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 32

5.3 Opening a Scenario . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 33

5.4 Saving a Scenario . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 34

5.5 Closing a Scenario . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 35

5.6 Merging scenarios . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 36

5.7 SCF Logical operations . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 36

5.8 Shapefile to Zones . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 36

Copyright © 2008 - 2020 ESA



Esov Software User Manual viii

6 Maps 37

6.1 Changing a Map . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 37

6.1.1 Map Toolwindow . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 37

6.1.1.1 Toolbar Elements . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 38

6.1.1.2 Rectangular Projection . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 38

6.1.1.3 Azimuthal Projection . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 39

6.1.1.4 Gnomonic Projection . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 40

6.1.1.5 Map Settings Validation . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 41

6.1.1.6 Map Legend Settings Panel . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 42

6.1.2 Map Tools . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 43

6.1.2.1 Zoom Tool . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 43

6.1.2.1.1 Rectangular Projection . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 43

6.1.2.1.2 Azimuthal/Gnomonic Projection . . . . . . . . . . . . . . . . . . . . . . . . . . . . 45

6.1.2.2 Rotation . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 45

6.1.2.3 Center . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 46

6.1.2.4 World Display . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 46

6.1.2.5 Compute Distance . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 46

6.2 Opening Multiple Maps . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 47

6.3 Printing a Map . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 47

7 Layer Management 48

7.1 The Layer Manager Toolwindow . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 48

7.1.1 Toolbar Elements . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 48

7.1.2 Layer Manager Tree . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 49

7.1.2.1 Geographical Layers Tree . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 49

7.1.2.2 Instruments Tree . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 52

7.1.2.3 User Shapes Tree . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 53

7.1.2.4 User Background Images Tree . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 53

7.2 The Segments Toolwindow . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 54

7.2.1 Segments Table . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 55

7.3 The Style Toolwindow . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 56

7.3.1 Toolbar Elements . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 56

7.3.2 Style Editors . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 57

7.3.2.1 Default Style Editor . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 57

7.3.2.2 Shoreline Style Editor . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 57

7.3.2.3 Grid Style Editor . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 58

7.3.2.4 Zone Style Editor . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 59

7.3.2.5 Station Style Editor . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 60

7.3.2.6 Station Perimeter Style Editor . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 61

7.3.2.7 Swath Style Editor . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 62

Copyright © 2008 - 2020 ESA



Esov Software User Manual ix

8 Tools 65

8.1 Azimuth / Elevation 2D Plot . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 65

8.1.1 The Location Selection dialog . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 65

8.1.1.1 Toolbar Elements . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 66

8.1.1.2 Location Selection Panel . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 66

8.1.2 The Azimuth / Elevation 2D Plot dialog . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 68

8.1.2.1 Toolbar Elements . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 69

8.1.2.2 Graphics Panel . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 69

8.1.2.3 Navigation Panel . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 71

8.1.2.4 Segments results table . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 72

8.1.2.5 Export Segments . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 73

8.2 Merging scenarios . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 73

8.2.1 The Scenario Selection dialog . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 74

8.2.1.1 Toolbar Elements . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 74

8.2.1.2 Scenario Selection Panel . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 74

8.2.2 The Time Control Toolwindow . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 75

8.2.2.1 Toolbar Elements . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 76

8.2.2.2 Time Interval Settings Panel . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 76

8.3 SCF Logical Operations . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 76

8.4 Shapefile to Zone transformation . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 77

9 Zone Databases 79

9.1 What is a Zone Database? . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 79

9.2 Zone Database Editor . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 79

9.2.1 Database Selection Panel . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 80

9.2.2 Zone List Panel . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 81

9.2.3 Zone Definition Panel . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 82

9.2.4 Editor Elements . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 85

9.2.5 Zone Validation . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 86

9.2.6 Button Panel . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 89

10 Station Databases 90

10.1 What is a Station Database? . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 90

10.2 Station Database Editor . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 90

10.2.1 Database Selection Panel . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 91

10.2.2 Station List Panel . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 92

10.2.3 Station Definition Panel . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 92

10.2.4 Editor Elements . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 94

10.2.5 Station Validation . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 95

10.2.6 Button Panel . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 97

Copyright © 2008 - 2020 ESA



Esov Software User Manual x

11 Data Export/Import 98

11.1 Export of Segments . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 98

11.1.1 SCF Export . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 98

11.1.2 LLF Export . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 99

11.1.3 UTF Export . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 100

11.1.4 KML Export . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 101

11.1.5 Importing CSV data to Excel . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 102

11.2 Export of Map Images . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 102

11.2.1 PDF Export . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 102

11.2.2 GIF Export . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 103

11.2.3 PNG Export . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 104

11.3 Import of data files . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 105

11.3.1 Shapefiles Import . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 105

11.3.2 Points of Interest Files Import . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 106

11.3.3 Sub Satellite Points File Import . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 107

12 User Preferences 108

12.1 Toolbar Elements . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 108

12.2 Scenario File Settings . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 108

12.3 Swath Export Settings . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 109

12.4 Zoom Settings . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 109

13 An Example for a ’Common Use Case’ 110

14 Application Layout 113

14.1 Toolwindow Arrangement . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 113

14.1.1 Toolwindow Modes . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 113

14.1.1.1 Autohide Mode . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 113

14.1.1.2 Docked Mode . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 114

14.1.1.3 Floating Mode . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 115

14.1.1.4 Closed Mode . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 116

14.2 Loading and saving Layouts . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 116

14.2.1 Default Layout . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 116

14.2.2 Saving a Layout . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 117

14.2.3 Loading a Layout . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 118

14.3 Look and Feel . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 119

15 Help System 121

15.1 Online Help . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 121

15.2 ’About’ Dialog . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 122

Copyright © 2008 - 2020 ESA



Esov Software User Manual xi

16 Stopping Esov 123

17 Updating Esov 124

17.1 Update Options . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 124

17.1.1 Updating when starting Esov . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 124

17.1.2 Updating from Help menu . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 127

17.1.3 Updating from Help menu . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 127

18 Hints and Tips 128

18.1 General EsovNG Tips . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 128

19 Appendix 129

19.1 Adding a new spacecraft to Esov . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 129

19.2 Command Line Interface . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 129

19.3 Examples of standard files used by Esov . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 130

19.3.1 Scenario File . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 130

19.3.2 Satellite Identification File . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 132

19.3.3 Swath Control File . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 133

19.3.4 Swath Definition File . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 135

19.3.5 Orbit Scenario File . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 135

19.3.6 Predicted Orbit File (POF) . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 135

19.3.7 Restituted Orbit File (ROF) . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 135

19.3.8 Zone Database File . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 135

19.3.9 Station Database File . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 135

19.3.10 Zone List File . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 135

19.3.11 Station List File . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 136

19.3.12 LLF File . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 137

19.3.13 UTF File . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 142

19.4 Software used in ESOV-NG . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 144

Copyright © 2008 - 2020 ESA



Esov Software User Manual xii

List of Figures

4.1 Main Window . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 11

4.2 File Menu . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 11

4.3 Exit Dialog . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 13

4.4 Edit Menu . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 13

4.5 Tools Menu . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 13

4.6 Window Menu . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 14

4.7 Help Menu . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 16

4.8 Main Toolbar . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 16

4.9 Toolwindows arranged as dockable components (example) . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 18

5.1 ’Create New Scenario’ dialog for spacecraft selection . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 20

5.2 New scenario in default layout . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 21

5.3 Orbit Toolwindow . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 22

5.4 Invalid orbit definitions . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 25

5.5 Orbit Settings Validation Dialog . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 25

5.6 Instruments Toolwindow . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 26

5.7 Zones Toolwindow . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 27

5.8 Zones Toolwindow Toolbar . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 28

5.9 Add Zones Dialog . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 28

5.10 Add Zones Dialog Toolbar . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 29

5.11 Stations Toolwindow . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 30

5.12 Stations Toolwindow Toolbar . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 30

5.13 Add Stations Dialog . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 31

5.14 Add Stations Dialog Toolbar . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 31

5.15 SSP Toolwindow . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 32

5.16 Open scenario dialog . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 33

5.17 Opened scenario ’AEOLUS’ . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 34

5.18 Save scenario dialog . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 35

5.19 Save scenario confirmation dialog . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 35

5.20 Close scenario confirmation dialog . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 35

Copyright © 2008 - 2020 ESA



Esov Software User Manual xiii

6.1 Map Toolwindow . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 38

6.2 Rectangular Projection Panel in the Map Toolwindow . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 39

6.3 Azimuthal Projection with default settings . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 40

6.4 Azimuthal and Gnomonic Projection Panel in the Map Toolwindow . . . . . . . . . . . . . . . . . . . . . . . . 40

6.5 Gnomonic Projection with default settings . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 41

6.6 Invalid map definitions . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 42

6.7 Map Legend Settings Panel . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 42

6.8 Zoomed map after clicking lat/lon point (0,0) in the initial map. . . . . . . . . . . . . . . . . . . . . . . . . . . . 44

6.9 Dragged area to be zoomed in. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 44

6.10 Zoomed map after the drag shown in the figure above. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 45

6.11 Azimuthal projection after clockwise rotation by 60 deg. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 46

6.12 Create a new map within the same scenario . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 47

6.13 The currently active map is shown in the Map View ("Map 2" in this example) . . . . . . . . . . . . . . . . . . . 47

7.1 Layer Manager Toolwindow . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 48

7.2 Layer Manager Toolwindow Toolbar . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 49

7.3 Layer Manager Toolwindow with collapsed Layer Manager Tree . . . . . . . . . . . . . . . . . . . . . . . . . . 49

7.4 Esov map with ’Background Image’ layer shown, all other layers hidden. . . . . . . . . . . . . . . . . . . . . . 50

7.5 As first figure, but ’Shore Lines / Political Borders’ layer also shown. . . . . . . . . . . . . . . . . . . . . . . . 50

7.6 As previous figure, but ’Grid’ layer also shown. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 51

7.7 As previous figure, but ’Zones’ layer also shown (’Africa’ as example). . . . . . . . . . . . . . . . . . . . . . . 51

7.8 As previous figure, but ’Stations’ layer also shown (’Hyderabad’ as example). . . . . . . . . . . . . . . . . . . . 52

7.9 Esov map with all layers shown. See text for details. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 53

7.10 Segments Toolwindow. No instrument selected. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 54

7.11 Segments Toolwindow with filled table (instrument MERIS selected). . . . . . . . . . . . . . . . . . . . . . . . 55

7.12 Segments Toolwindow: Visibility toggle - second segment hidden. . . . . . . . . . . . . . . . . . . . . . . . . . 56

7.13 Style Toolwindow . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 56

7.14 Style Toolwindow Toolbar . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 56

7.15 Style Toolwindow: Color Editor . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 57

7.16 Style Toolwindow: Color Editor with option to define more colors . . . . . . . . . . . . . . . . . . . . . . . . . 58

7.17 Style Editor for Shorelines / Political Borders . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 58

7.18 Grid Style Editor: Resolution Selection . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 59

7.19 Grid Style Editor: Style Selection . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 59

7.20 Grid Style Editor: Label Option Selection . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 59

7.21 Grid Style Editor . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 59

7.22 Zone Style Editor . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 60

7.23 Station Style Editor: Style Selection . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 61

7.24 Station Style Editor . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 61

7.25 Station Perimeter Style Editor . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 62

Copyright © 2008 - 2020 ESA



Esov Software User Manual xiv

7.26 Showing a station’s topocentric elevation in steps of 30 deg. . . . . . . . . . . . . . . . . . . . . . . . . . . . . 62

7.27 Station Style Editor: Style Selection . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 63

7.28 Station Style Editor: Style Selection . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 63

7.29 Swath Style Editor . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 63

7.30 Segments Toolwindow: Individual Color Selection . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 63

7.31 MERIS Swaths with individual colors . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 64

8.1 ’Azimuth / Elevation 2D Plot...’ entry in ’Tools’ menu . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 65

8.2 Selection dialog for the location for azimuth/elevation plot . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 66

8.3 Selection dialog for the location for azimuth/elevation plot: graphical editing mode active . . . . . . . . . . . . . 67

8.4 Selection dialog for the location for azimuth/elevation plot: Invalid longitude coordinate . . . . . . . . . . . . . 67

8.5 Selection for the location for azimuth/elevation plot: Validation Info dialog . . . . . . . . . . . . . . . . . . . . 68

8.6 Azimuth / Elevation 2D Plot dialog . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 68

8.7 Plot customize menu . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 69

8.8 Dragged zoom selection rectangle . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 70

8.9 Zoom selection result . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 70

8.10 ’Chart Properties’ dialog . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 71

8.11 Zoom options submenu in Plot settings menu . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 71

8.12 Colour editor for azimuth/elevation curves . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 72

8.13 No segments to be displayed in Azimuth / Elevation 2D Plot . . . . . . . . . . . . . . . . . . . . . . . . . . . . 73

8.14 ’Merge Scenarios’ in Tools menu . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 74

8.15 Selection dialog for merging scenarios . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 74

8.16 Info dialog: scenarios to be merged not selected . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 75

8.17 Window displaying a merged scenario for the spacecrafts ENVISAT, CRYOSAT and ADM . . . . . . . . . . . . 75

8.18 Time Control Toolwindow . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 76

8.19 SCF logical operations dialog . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 77

8.20 Shapefile to Zones tool dialog . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 77

9.1 Zone Database Editor . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 80

9.2 Zone Database Selection Panel . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 81

9.3 Error dialog: Wrong database type . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 81

9.4 Zone List Panel . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 81

9.5 Zone Definition Panel . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 82

9.6 Creating a circular zone in ’graphical editing’ mode. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 83

9.7 Circular zone created in ’graphical editing’ mode. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 84

9.8 Polygon zone created in ’graphical editing’ mode. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 85

9.9 Delete Zone Confirmation Dialog . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 86

9.10 Buttons ’Insert New Zone’, ’Delete Selected Zone’ and ’Edit Selected Zone’ (from left to right) . . . . . . . . . 86

9.11 Buttons ’Clear Zone Fields’, ’Save Zone Changes’ and ’Cancel Zone Changes’ (from left to right) . . . . . . . . 86

Copyright © 2008 - 2020 ESA



Esov Software User Manual xv

9.12 Invalid zone definition: ID and Description missing, polygon has less than 3 points . . . . . . . . . . . . . . . . 87

9.13 Zone validation dialog . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 87

9.14 Invalid circular zone definition: Center Longitude and Diameter out of range . . . . . . . . . . . . . . . . . . . . 88

9.15 Zone validation dialog . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 88

9.16 Polygon point invalid (out of range) . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 88

9.17 Invalid degree value dialog . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 88

9.18 Invalid polygon (self-intersecting due to the latitude value in point 4) . . . . . . . . . . . . . . . . . . . . . . . . 89

9.19 Zone validation dialog . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 89

9.20 Zone Database Editor Button Panel . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 89

10.1 Station Database Editor . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 91

10.2 Station Database Selection Panel . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 91

10.3 Error dialog: Wrong database type . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 92

10.4 Station List Panel . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 92

10.5 Station Perimeters: Example for setting ’AOS/LOS with Mask’ . . . . . . . . . . . . . . . . . . . . . . . . . . . 93

10.6 Station Perimeters: Example for setting ’Mask only’ . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 93

10.7 Station Definition Panel . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 94

10.8 Delete Station Confirmation Dialog . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 95

10.9 Buttons ’Delete Selected Station’ and ’Edit Selected Station’ (from left to right) . . . . . . . . . . . . . . . . . . 95

10.10Buttons ’Clear Station Fields’, ’Save Station Changes’ and ’Cancel Station Changes’ (from left to right) . . . . . 95

10.11Invalid station definition: ID and Description missing . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 95

10.12Station validation dialog . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 96

10.13Invalid AOS/LOS definitions: AOS > 90 deg., LOS empty . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 96

10.14Station validation dialog . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 96

10.15Invalid: LOS > AOS . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 96

10.16Station validation dialog . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 97

10.17Station Database Editor Button Panel . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 97

11.1 Save SCF Dialog . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 99

11.2 Save SCF Confirmation Dialog . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 99

11.3 Save LLF Dialog . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 100

11.4 Save LLF Confirmation Dialog . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 100

11.5 Save UTF Dialog . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 101

11.6 Save UTF Confirmation Dialog . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 101

11.7 Save KML Dialog . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 102

11.8 Save PDF File Dialog . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 103

11.9 Save PDF File Confirmation Dialog . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 103

11.10Save GIF File Dialog . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 104

11.11Save GIF File Confirmation Dialog . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 104

Copyright © 2008 - 2020 ESA



Esov Software User Manual xvi

11.12Save PNG File Dialog . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 105

11.13Save PNG File Confirmation Dialog . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 105

11.14Import Shapefile chooser Dialog . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 106

11.15Import Points of Interest chooser Dialog . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 106

11.16Sub-Satellite Points File chooser Dialog . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 107

12.1 User Preferences Dialog . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 108

12.2 Zoom with crosshair cursor: purple lines are the crosshair cursor . . . . . . . . . . . . . . . . . . . . . . . . . . 109

13.1 ’Common Use Case’ scenario. See text for details. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 112

14.1 Toolwindows in Autohide mode on left main frame edge. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 114

14.2 Layer Manager Toolwindow shown in Autohide mode. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 114

14.3 Title bar buttons of a toolwindow shown in autohide mode. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 114

14.4 Layer Manager Toolwindow shown in docked mode. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 115

14.5 Title bar buttons of a toolwindow shown in docked mode. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 115

14.6 Layer Manager Toolwindow shown in floating mode. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 115

14.7 Title bar buttons of a toolwindow shown in floating mode. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 116

14.8 Esov with default layout . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 117

14.9 Save layout dialog . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 118

14.10Save layout confirmation dialog . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 118

14.11Open scenario dialog . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 119

14.12Look and Feel Submenu . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 120

15.1 Esov Online Help . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 121

15.2 ’About’ Dialog . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 122

16.1 Exit confirmation dialog . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 123

17.1 Esov version check dialog . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 124

17.2 Esov updater dialog . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 125

17.3 Esov update: new version available . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 125

17.4 Esov update: downloading new version . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 126

17.5 Esov update: download finished . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 126

17.6 Esov update: latest version is used . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 127

17.7 List of missions to be updated. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 127

17.8 List of missions to be updated. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 127

Copyright © 2008 - 2020 ESA



Esov Software User Manual 1 / 145

Chapter 1

Introduction

1.1 Scope

This document is the software user manual (SUM) for the Esov software.

1.2 Acronyms and Nomenclature

1.2.1 Acronyms

• ADD - Architecture Design Document

• CFI - Customer Furnished Item

• DME - Deimos Engenharia

• EOCFI - Earth Observation CFI

• ESA - European Space Agency

• ESTEC - European Space Technology and Research Centre

• IDF - (Satellite) Identification File

• KML - Keyhole Markup Language

• OSF - Orbit Scenario File

• POF - Predicted Orbit File

• ROF - Restituted Orbit File

• TLE - Two-line element

• SCF - Swath Control File

• SDF - Swath Definition File

• SLF - Station List File

• STP - Software Test Plan

• SUM - Software User Manual

• ZLF - Zone List File
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1.2.2 Nomenclature

1.3 Applicable Documents

• [ADD] Esov Architectural Design Document. Issue 1.0, 02/21/2008.

• [STP] Esov Software Test Plan. Issue 1.0, 02/21/2008.

1.4 Reference Documents

• [CFI] EO CFI SW Data Handling User Manual (Ref. EO-MA-DMS-GS-0007). Issue 4.14.
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Chapter 2

Software Installation

This section describes how to get, install and start the EsovNG software. It also describes the folder structure and files available
after a successful installation.

2.1 Usage Requirements

The software is a Java program. Currently, it will run on the platforms Windows 7/8/10, Mac OS X and Linux for 64-bit.

2.1.1 General Requirements

The software requires:

• a 1.7 version of the Java Development Kit (JDK) (included in the Esov software for Windows and Mac OS X).

• 150+ Mb of hard disk space

• 512+ Mb RAM

2.1.2 Windows 7/8/10

The software requirements are:

• Microsoft Windows 7/8/10

The display hardware requirements are:

• at least 1024 X 786 resolution is advised

• at least 16-bits colours are advised

2.1.3 Mac OS X

The software requirements are:

• Mac OS X 10.7 or above

The display hardware requirements are:

• at least 1024 X 786 resolution is advised

Copyright © 2008 - 2020 ESA



Esov Software User Manual 4 / 145

2.1.4 Linux

The software will run on common Linux distributions fulfilling the general requirements listed above.

The display hardware requirements are:

• at least 1024 X 786 resolution is advised

2.2 How to get the Software

The EsovNG software is distributed by ESA through the World Wide Web (WWW). Using a web browser go to the page:
http://eop-cfi.esa.int/index.php/applications/esov/

Following the instructions given on the page, and you will be able to save the distribution file on your local disk.

An EsovNG distribution consists of one single installer file for the specific operating system:

• Windows 64-bit: EsovNG_windows-x64_X_X.exe

• Mac OS X 64-bit: EsovNG_macintel64_X_X.dmg

• Linux 64-bit: EsovNG_linux64_X_X.sh

These installers contain all files as described later on in Section 2.5.

2.3 Esov Installation / Uninstall Process

The installation and uninstall of Esov is very simple. Installation and uninstall will basically be guided through an Install4j
installation wizard.

2.3.1 Windows 7/8/10 Installation

On Windows, simply run the executable installer ’EsovNG_windows-x64_X_X.exe’. An installation wizard will then guide you
through the rest of the installation process.

2.3.2 Mac OS X Installation

On Mac OS X, first unpack the dmg package ’EsovNG_macintel64_X_X.dmg’ by double-clicking it in a Finder window. A new
Finder window will be opened, showing the installer ’Esov Installer’. Double-click this installer. An installation wizard will then
guide you through the rest of the installation process.

2.3.3 Linux Installation

On Linux, simply run the shell script ’EsovNG_linux64_X_X.sh’. An installation wizard will then guide you through the rest of
the installation process.

2.4 Uninstalling the Installed Software

2.4.1 Windows 7/8/10 Uninstall

On Windows, simply run the executable ’uninstall.exe’ in the directory Esov was formerly installed. An installation wizard will
then guide you through the rest of the uninstall process.

Copyright © 2008 - 2020 ESA



Esov Software User Manual 5 / 145

2.4.2 Mac OS X Uninstall

On Mac OS X, double-click the file ’Esov Uninstaller’ in a Finder window in the directory Esov was formerly installed. An
installation wizard will then guide you through the rest of the uninstall process.

2.4.3 Linux Uninstall

On Linux, simply run the shell script ’uninstall.sh’ in the directory Esov was formerly installed. An installation wizard will then
guide you through the rest of the uninstall process.

2.5 Overview of Files and Folder Structure

2.5.1 Installation Directory

The Esov installation directory (chosen during the installation process) consists of the following files and subfolders:

• ’instrument_swath’ : subfolder containing one further subfolder per defined spacecraft. These spacecraft-specific sub-subfolders
each contain a satellite identification file (.idf), and a swath definition file per instrument.

Note that this subfolder (as all the other ones in the installation directory) is removed and re-installed every time the Esov
application is re-installed or updated. This means that new spacecrafts (satellite identification and swath definition files) should
not be added manually to this folder by the user (although possible in principie). For this purpose, a dedicated subfolder in the
Application directory is foreseen (see below).

• ’orbit_scenario_files’ : subfolder containing one further subfolder per defined spacecraft. These spacecraft-specific sub-
subfolders each contain default orbit files (pre-loadable by the application).

Note that this subfolder (as all the other ones in the installation directory) is removed and re-installed every time the Esov
application is re-installed or updated. This means that new spacecrafts (satellite identification and swath definition files) should
not be added manually to this folder by the user (although possible in principie).

• ’lib’ : subfolder with all jar archives used by the application.

• ’resources/geodata/background’ : subfolder containing background image files (one .jpg with an image itself, and a world file
(.wld) with image information).

• ’resources/geodata/shapes’ : subfolder containing shape files to build up a layer with shorelines and political borders.

• application executable : file to start the application:

– Windows: ’esovng.exe’

– Mac OS X: ’esovng.app’

– Linux: ’esovng.sh’

• uninstaller file : file to uninstall the application:

– Windows: ’esovng.exe’

– Mac OS X: ’esovng.app’

– Linux: ’esovng.sh’

• ’LICENSE.TXT’ : file containing license information.

• ’readme.html’ : a readme file.

• ’.install4j’ : folder created by the installer (not used by Esov).
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2.5.2 Application Directory

The Esov application directory is meant to contain specific data wich is maintained and created by the application (e.g., zone/s-
tation databases, layout data, scenario files or swath control files). The location of this directory is platform dependent:

• Windows 7/8/10: ’C:/Users/username/AppData/Roaming/Esov’

• Mac OS X: ’/Users/username/Library/Application Support/Esov’

• Linux: ’/home/username/.esovng’

After Esov has been launched for the first time, this folder contains a subfolder ’user_instrument_swath’, in which new space-
crafts can be added by the user, following the file conventions as for the subfolder ’instrument_swath’ in the installation directory.
At startup, Esov will automatically search for spacecrafts in this folder as well. In this way, user-defined spacecrafts will not be
lost if Esov is re-installed or updated.

Furthermore, this folder contains a subfolder ’tmp’ in which internal data used by the application is stored. This folder is deleted
and re-created every time the application is started, therefore, the user should not store relevant data there. However, the user is
free to create own subfolders in the application directory to structure his data as he/she likes.

NOTE: in Mac OS X and Windows the above listed folders are by default hidden to the users. To make these folders visible:

• Mac OS X 10.7 (Lion) and 10.8 (Mountain Lion): Make the user Library folder permanently visible by changing the ’hidden’
flag’ using Terminal:

1. Launch Terminal.app (from User account)

2. 2. Type the command: chflags nohidden ~/Library

3. Press return

• Mac OS X 10.9 (Mavericks) and 10.10 (Yosemite): Make the user Library folder permanently visible by changing the settings
using Finder:

1. Open the user home folder (/Users/username) in the Finder

2. Select View --> Show View Options

3. Enable the option Show Library Folder

4. Close the View Options window

• Windows 7, 8, 10 : Make the AppData folder visible by changing the settings using Windows Explorer:

1. Go to Windows Explorer to open a window showing the file system

2. Select Computer --> OSDisk (C:)

3. Click ’Organize’ on the window menu bar

4. Select ’Folder and search options’

5. Select the ’View’ tab

6. Under Hidden files and folders, select the option ’Show hidden files, folders, and drives’

7. Click ’Apply’ and ’OK’

2.5.3 Esov data file types

2.5.3.1 Scenario Files

A Scenario File is the physical instance of an Esov scenario (see Chapter 5). This file follows ESA’s Earth Observation File XML
standard. It has the extension ’.xml’. An example listing for a Scenario File can be found in Section 19.3.1

Copyright © 2008 - 2020 ESA



Esov Software User Manual 7 / 145

2.5.3.2 Satellite Identification Files

A Satellite Identification File contains the default settings to identify a satellite. This file follows ESA’s Earth Observation File
XML standard. It has the extension ’.idf’. An example listing for a Satellite Identification can be found in Section 19.3.2

2.5.3.3 Swath Control Files

A Swath Control File (also known as a Mission Timelines File) contains time segments which allow to recompute spatial satellite
swaths with Esov. This file follows ESA’s Earth Observation File XML standard. It has the extension ’.scf’. An example listing
for a Swath Control File can be found in Section 19.3.3, see also Section 11.1.1

2.5.3.4 Swath Definition Files

A Swath Definition File contains the information for the instrument-specific definition of a swath (e.g., ’point swath’ type, ’line
swath’ type etc.). This file follows ESA’s Earth Observation File XML standard. The file extension is mission-dependent (set in
the IDF). An example listing for a Swath Definition File can be found in Section 19.3.4

2.5.3.5 Orbit Scenario Files

A Orbit Scenario File contains information about the specific orbit of a satellite (i.e., orbit changes). This file follows ESA’s
Earth Observation File XML standard. An example listing for a Orbit Scenario File can be found in Section 19.3.5

2.5.3.6 Predicted/Restituted Orbit Files (POF/ROF)

Predicted/Restituted Orbit Files (POF/ROF) provide orbit information in a different way. From the point of view of the imple-
mentation in Esov, the main differences between the OSF and POF/ROF are the following:

• the POF/ROF have limited validity while the OSF is valid from a given time onwards

• in the case of a POF/ROF, the relevant information to be displayed in the Info panel of the Orbit toolwindow will be the
start/stop validity times and their corresponding start/stop orbit numbers

These files also follow ESA’s Earth Observation File XML standard. Example listings for a POF and a ROF can be found in
Section 19.3.6 and Section 19.3.7, respectively.

2.5.3.7 Zone Database Files

A Zone Database File contains information on zones (e.g., their polygon points) which can be used by Esov. This file follows
ESA’s Earth Observation File XML standard. An example listing for a Zone Database File can be found in Section 19.3.8

2.5.3.8 Station Database Files

A Station Database File contains information on stations (e.g., their location) which can be used by Esov. This file follows ESA’s
Earth Observation File XML standard. An example listing for a Station Database File can be found in Section 19.3.9

2.5.3.9 Zone List Files

A Zone List File contains a simple list of zones represented by their ID. This list can be used by Esov to restore a set of zones
formerly defined by the user. This file follows ESA’s Earth Observation File XML standard. It has the extension ’.zlf’. An
example listing for a Zone List File can be found in Section 19.3.10
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2.5.3.10 Station List Files

A Station List File contains a simple list of stations represented by their ID. This list can be used by Esov to restore a set of
stations formerly defined by the user. This file follows ESA’s Earth Observation File XML standard. It has the extension ’.slf’.
An example listing for a Station List File can be found in Section 19.3.11

2.5.3.11 LLF Files

A latitude/longitude file (LLF) contains the latitude/longitude information for all distinct points of a segment (start/stop as well
as intermediate points). LLF files can be stored in the three formats XML, CSV and ASCII. Example listings for LLF Files in all
these formats can be found in Section 19.3.12, see also Section 11.1.2

2.5.3.12 UTF Files

A UTF file contains the time information (time_from_anx and UTC) for the start and stop points of a segment. UTF files can
be stored in the three formats XML, CSV and ASCII. Example listings for UTF Files in all these formats can be found in
Section 19.3.13, see also Section 11.1.3

2.6 Getting Further Information

For more information, please contact:

• esov@eopp.esa.int
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Chapter 3

Starting Esov

General remark: The screen shots in this manual have been taken from Esov running on a Windows system. Single GUI
components may look slightly different on other platforms (i.e., depending on the specific ’Look and Feel’), but there is no
functional difference between them.

3.1 Windows XP, Vista, 7, 8, 10

3.1.1 Starting the Esov executable

To start Esov, select Esov in the Windows Start menu or double click on the Esov icon on the Windows desktop, if configured
during the installation. If not, open a Windows Explorer and go to the Esov installation folder and double click on esovng.exe.
A splash screen appears, followed by the Esov initial frame (Figure 4.1).

3.2 Mac OS X

3.2.1 Starting the Esov application

To start Esov, double click on the Esov icon on the desktop, if configured during the installation. If not, open a Finder window
and go to the Esov installation folder and double click on esovng.app. A splash screen appears, followed by the Esov initial
frame (Figure 4.1).

3.3 Linux

3.3.1 Starting the Esov application

To start Esov, double click on the Esov icon on the desktop, if configured during the installation. If not, open an Explorer window
and go to the Esov installation folder and double click on esovng. A splash screen appears, followed by the Esov initial frame
(Figure 4.1).
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Chapter 4

Basic Concepts

4.1 Scenario

The basic component in Esov is referred as Scenario. A Scenario resembles a set of settings for a spacecraft. These settings con-
tain orbital, instrumental and geographical settings as well as regional (in Esov referred as zones) and ground station definitions.
These settings together describe all necessary elements for calculating orbital swaths and intersection points (e.g. instrument
swaths intersecting reception areas of ground stations).

Furthermore, a Scenario stores information related to the presentation of its data. It holds an Esov Map, which contains visibility,
boundaries and projectional information. Thus an Esov Map provides a certain view or perspective onto a Scenario. Style
information for all presentable elements is also held within the Scenario.

The physical representation of a Scenario is given by a Scenario File, which holds the information as mentioned above in an
XML file. Scenario Files can be imported into or exported from the Esov application. Scenarios are explained in Chapter 5.

4.2 User Interface Overview

4.2.1 Main Window

Esov usually starts up with an almost empty Main Window (Figure 4.1). The only user interface components presented are the
Main Menu Bar and the Main Toolbar, both located right below the top Main Window border, as well as the Application Status
Bar with the usual progress, cursor position, insert/overwrite and memory status elements. Note that most elements of the Main
Toolbar are not active. The only active elements are for creating or opening Scenarios, and for invoking the Help System. In
order to start using Esov, first create a new scenario or open a scenario stored on the file system.
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Figure 4.1: Main Window

4.2.2 Menus

4.2.2.1 File Menu

Figure 4.2: File Menu

The File Menu (Figure 4.2) exhibits the following items:

New

Selecting this menu item creates a new scenario, see Section 5.1 for further explanations.

New Map
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Selecting this menu item creates a new map view within the current scenario, see Section 6.2 for further explanations. This
command is only available when a scenario is open.

Open

Selecting this menu item opens a scenario file stored on the file system, see Section 5.3 for further explanations.

Close

Selecting this menu item closes the current scenario, see Section 5.5 for further explanations.

Save

Selecting this menu item saves the current scenario to a file on the file system, see Section 5.4 for further explanations. Note that
no new file is created when the current scenario is already associated with a file.

Save As

Selecting this menu item saves the current scenario to a file on the file system, see Section 5.4 for further explanations. Note that
a new file is created even when the current scenario is already associated with a file.

Print

Selecting this menue item prints the current map view.

Export Segments

Selecting this menu item exports the current segments to the file system, see Section 11.1 for further explanations.

Export Image

Selecting this menu item exports an image of the current map view to the file system, see Section 11.2 for further explanations.

Import...

Selecting this menu item imports data in several different formats: Shapefiles, Points of Interest, Sub-Satellite points, , see
Section 11.3 for further explanations.

Exit

Selecting this menu item exits Esov. Note that the user is ask to confirm the exit unless the Do not ask again option has been
selected in the Exit Dialog (see Figure 4.3).

Please note: On Mac OS X platforms, the File menu does not contain this ’Exit’ entry. Here, the exit functionality is provided
through the ’Quit Esov’ entry in the specific ’Esov’ application menu (provided automatically, as for any application on Mac OS
X).
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Figure 4.3: Exit Dialog

4.2.2.2 Edit Menu

Figure 4.4: Edit Menu

The Edit Menu (Figure 4.4) exhibits the following items:

Zone Database

Selecting this menu item opens the Zone Database Editor, see Section 9.2 for further explanations.

Station Database

Selectiing this menu item opens the Sation Database Editor, see Section 10.2 for further explanations.

User Preferences

Selecting this menu item opens the User Preferences Dialog, see Chapter 12 for further explanations.

4.2.2.3 Tools Menu

Figure 4.5: Tools Menu

The Tools Menu (Figure 4.5) exhibits the following items:

Azimuth / Elevation 2D Plot...
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Selecting this menu item opens the location selection dialog for the Azimuth / Elevation 2D Plot, see Section 8.1.1 for further
explanations.

Merge Scenarios

Selecting this menu item opens the selection dialog for merging scenarios, see Section 5.6 for further explanations.

SCF Logical Operations

Selecting this menu item opens the selection dialog for performing logical operations on SCF files, see Section 5.7 for further
explanations.

Shapefiles to Zones

Selecting this menu item opens the selection dialog for transforming a shapefile to a zone database file, see Section 5.8 for further
explanations.

4.2.2.4 Window Menu

Figure 4.6: Window Menu

The Window (Figure 4.6) exhibits the following items:

Layer Manager

Selecting this menu item displays the Layer Manager, see Section 7.1 for further explanations. Note that this menue item is
activate only when a scenario has been opened or created.

Segments

Selecting this menu item displays the Segments Toolwindow, see Section 7.2 for further explanations. Note that this menu item
is activate only when a scenario has been opened or created.
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Style

Selecting this menu item displays the Style Editor Window. The Style Editor allows to change the rendering style for entities
displayed in the current map. Note that this menu item is activate only when a scenario has been opened or created.

Map

Selecting this menu item displays the Map Toolwindow, see Section 6.1.1 for further explanations. Note that this menu item is
activate only when a scenario has been opened or created.

Orbit

Selecting this menu item displays the Orbit Toolwindow, see Section 5.2.1 for further explanations. Note that this menu item is
activate only when a scenario has been opened or created.

Instruments

Selecting this menu item displays the Instruments Toolwindow, see Section 5.2.2 for further explanations. Note that this menu
item is activate only when a scenario has been opened or created.

Zones

Selecting this menu item displays the Zones Toolwindow, see Section 5.2.3 for further explanations. Note that this menu item is
activate only when a scenario has been opened or created.

Stations

Selecting this menu item displays the Stations Toolwindow, see Section 5.2.5 for further explanations. Note that this menu item
is activate only when a scenario has been opened or created.

Map Overview

Selecting this menu item displays the Map Overview Toolwindow with a thumbnail of the map current viee location. Note that
this menu item is activate only when a scenario has been opened or created.

Sub Satellite Position

Selecting this menu item displays the Sub-Satellite Position Toolwindow, see Section 5.2.7 for further explanations. Note that
this menu item is activate only when a scenario has been opened or created.

Load Layout

Selecting this menu item loads a toolwindow layout from the File Sytem. Note that this menu item is activate only when a
scenario has been opened or created.

Save Layout

Selecting this menu item saves the current toolwindow layout to the File Sytem. Note that this menu item is activate only when
a scenario has been opened or created.
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Reset Layout

Selecting this menu item resets the current toolwindow layout to the default layout. Note that this menu item is activate only
when a scenario has been opened or created.

Show / Hide Docked Toolwindows

Selecting this menu item toogles the visibility of docked Toolwindows. Note that this menu item is activate only when a scenario
has been opened or created.

Look and Feel

Selecting this menu item allows to select a graphical user interface look and feel other than the default.

4.2.2.5 Help Menu

Figure 4.7: Help Menu

The Help Menu exhibits the following items:

Help...

Selecting this menu item opens the Help System, see Chapter 15 for further explanations.

Check for new Esov versions...

Selecting this menu item opens the Esov Online Update Dialog, see Chapter 17 for further explanations.

About...

Selecting this menu item displays the Esov version and license information.

4.2.3 Main Toolbar

Figure 4.8: Main Toolbar
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Selecting this toolbar element creates a new scenario, see Section 5.1 for further explanations.

Selecting this toolbar element opens a scenario file stored on the file system, see Section 5.3 for further explanations.

Selecting this toolbar element saves the current scenario to a file on the file system, see Section 5.4 for further explanations.

Selecting this toolbar element enables/disables the zoom mechanism for the current map view. If the zoom mechanism is enabled,
the center mechanism (see below) is disabled (and vice versa).

Selecting this toolbar element zooms out of the current map view.

Selecting this toolbar element enables/disables the center mechanism for the current map view. If the center mechanism is
enabled, the zoom mechanism (see above) is disabled (and vice versa).

Selecting this toolbar element displays the whole world in the current map view.

Selecting this toolbar element to rotate the current map view clockwise by 30 degrees. Note that this item only applies to the
azimuthal and gnomonic projections.

Selecting this toolbar element rotates the current map view counter-clockwise by 30 degrees. Note that this item only applies to
the azimuthal and gnomonic projections.

Selecting this toolbar element activates the distance calculator. To compute the geodetic distance between two point first double
click on the initial point (marked by a pin) then click on the second point (marked by a different coloured pin). The distance label
is shown next to the target point.
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Selecting this toolbar element opens the Software User Manual.

4.2.4 Toolwindows

In Esov, the major subcomponents of a Scenario are administrated in Toolwindows. There are distinct toolwindows for the
instruments of a spacecraft and their current scope, for the orbital settings underlying the computation of swaths, zones and
groundstations to be considered, layering and style information, and finally for a tabular summary of the computed swath seg-
ments. With the JIDE Docking Framework which comes with Esov, toolwindows can be arranged very flexible (shown/hidden,
docked, moved etc.). This will be explained in more detail in Chapter 14.

Figure 4.9: Toolwindows arranged as dockable components (example)

4.2.5 Maps

The key component for all graphical representation of a scenario is the Map. The map is held in a distinct pane which is, in
opposite to toolwindows (see below), always visible in Esov. Basically, the map shows a map of the Earth, represented by a layer
of shorelines/political border and/or a satellite background image. On this map, the computed instrument swaths are drawn. The
map can be viewn under different projections and provides tools (such as zooming, rotation) to offer to the user an optimal view
of the scenario which is currently analyzed. Maps are explained in Chapter 6.
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4.2.6 Layers

The representation of a scenario and the current view on it is provided by a concept of different Layers, which are administrated
(i.e., shown or hidden) with a special toolwindow, the Layer Manager. This concept distinguishes between pure view layers
which can always be shown/hidden independent of swaths being calculated (such as zones, groundstations, background image),
and layers depending on the current spacecraft and its orbit/instruments settings. All layers are clearly arranged in a tree view
within the Layer Manager toolwindow.
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Chapter 5

Scenarios

5.1 Creating a New Scenario

To create a new scenario, click ’New’ in the File menu, or the button ’New Scenario’ in the main toolbar. A dialog ’Create
New Scenario’ appears (Figure 5.1.)., which contains a drop-down list with available spacecrafts. Select the spacecraft you want
to work with, and click OK. The dialog ’Create New Scenario’ is closed, and a new, unnamed scenario is opened in the main
frame. The arrangement of the toolwindows will be the same as in other open frames or, if no other frames are open, as it was
when the previous session was left. When the application is launched the first time after installation, a default layout will be used
(Figure 5.2.).

Figure 5.1: ’Create New Scenario’ dialog for spacecraft selection
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Figure 5.2: New scenario in default layout

5.2 Changing a Scenario

Basically, a scenario will be changed every time if scenario-relevant parameters are changed by the toolwindows, and if these
changes are manually or automatically (depending on the distincs toolwindow) applied. This will be explained in detail in
the following sections. A scenario will not be changed by actions which purely affect the visibility of layers (e.g., show/hide
latitude/longitude grid lines).

5.2.1 Orbit Toolwindow

The Orbit toolwindow is the GUI component in which the orbit settings of a scenario can be defined.

5.2.1.1 Toolbar Elements

In the Orbit Panel Toolbar the user can find two elements:

• Help Button: Invokes the Online Help for this toolwindow.

• ’Apply’ button: Invokes a validation of format and consistence of the toolwindow input elements. If the input is valid, a swath
computation based on this input is performed.

5.2.1.2 Orbit Panel (’Use orbit parameters’ input mode)

In the Orbit Panel (see Figure 5.3.) the user can change the repeat cycle of the satellites orbit, the cycle length, drift, absolute
reference orbit, MLST (Mean Local Solar Time), longitude ascending node crossing, and date. For these orbit parameters, there
are generally four input modes: ’Use orbit parameters’, ’Use Orbit Scenario File’, ’Use Predicted / Restituted Orbit File’ and
’Use TLE’. The OSF or POF/ROF mode can be selected by the ’Use Orbit Scenario File’, ’Use Predicted / Restituted Orbit File’
or ’Use TLE’ radiobuttons, respectively, at the top of the orbit section. In ’Use orbit parameters’ mode (see Figure 5.3) the user
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can type in a value for the repeat cycle. Accordingly, the possible values for the cycle length will be given in a drop-down box.
These values are computed by the application, based on the values for Minimum/Maximum Orbits per Day, as specified in the
IDF file of the current spacecraft. If no valid cycle length exists for the given repeat cycle, the drop-down box will remain empty,
which will result in a validation error when the orbit settings are applied for swath computation (see Section 5.2.1.12). All other
parameters need to be typed in a simple text field, except for the date which can be chosen via a calendar which pops up when
the date text field is clicked.

Figure 5.3: Orbit Toolwindow

5.2.1.3 OSF Selection

With the radiobutton ’Use Orbit Scenario File’, the user can set the ’Use Orbit Scenario File’ input mode of orbit parameters.
With the selection of this radiobutton, the Orbit panel for the Use orbit parameters input is replaced by the OSF File Selection
panel and, after the selection of an OSF file, the OSF Orbit Settings panel (see below).

5.2.1.4 OSF File Selection Panel

The OSF File Selection Panel consists of a non-editable text field and a ’Select OSF File’ button. When this button is clicked, an
’Open OSF File’ dialog appears. Its current directory is the Esov application directory. If an OSF file is selected and opened by
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clicking ’Open’ in the ’Open OSF File’ dialog, the ’OSF Orbit Settings Panel’ is displayed below.

5.2.1.5 OSF Orbit Settings Panel

The OSF Orbit Settings Panel consists of a table listing the orbit changes which were read from the selected OSF file. The
parameters are in particular: repeat cycle, cycle length, absolute reference orbit, longitude ascending node crossing, first orbit,
last orbit, and drift. With a radio button in the first column, a distinct set of these parameters can be chosen for the swath
computations.

5.2.1.6 POF/ROF Selection

With the radiobutton ’Use Predicted / Restituted Orbit File’, the user can set the ’Use Predicted / Restituted Orbit File’ input
mode of orbit parameters. With the selection of this radiobutton, the Orbit panel for the Use orbit parameters input is replaced by
the POF/ROF File Selection panel and, after the selection of a POF/ROF file, the Info and Graphical Settings panels (see below).

5.2.1.7 POF/ROF File Selection Panel

The POF/ROF File Selection Panel consists of a non-editable text field and a ’Select POF/ROF File’ button. When this button is
clicked, an ’Open POF/ROF File’ dialog appears. Its current directory is the Esov application directory. When a POF/ROF file
has been successfully loaded, the graphical settings panel is adjusted to cover the complete validity defined in the file.

Loading of a ROF file may take some time, depending on the number of state vector entries stored in the file. During the loading
procedure, ESOV is blocked and will not react on user interaction. A progressbar visualizes this state.

5.2.1.8 TLE Selection

With the radiobutton ’Use TLE’, the user can set the ’Use TLE’ input mode of orbit parameters. With the selection of this
radiobutton, the Orbit panel for the Use orbit parameters input is replaced by the TLE File Selection panel and, after the selection
of a TLE file, the Info and Graphical Settings panels (see below).

5.2.1.9 TLE File Selection Panel

The TLE File Selection Panel consists of a non-editable text field and a ’Select TLE File’ button. When this button is clicked, an
’Open TLE File’ dialog appears. Its current directory is the Esov application directory. When a TLE file has been successfully
loaded, the graphical settings panel is adjusted to cover the complete validity defined in the file.

5.2.1.10 Info Panel

The Info panel displays additional relevant parameters which depend on the orbit settings defined manually or from an OSF file.
The parameters are in particular: orbital period, equatorial separation, orbits per day, altitude (max., min., avg.), and date of
ascending node crossing. In case of relevant changes in the orbit settings (i.e., a selection of a different OSF orbit change), the
displayed parameters in the Info panel are updated accordingly.

When using ESOV with a POF/ROF file loaded, the info panel displays the validity range of the orbit definition loaded. The
parameters in this case are the valid orbit range (start and stop orbit) and the valid time range (start and stop UTC).

5.2.1.11 Graphical Settings Panel

In the Graphical Settings Panel, the parameters defining the range of orbits displayed in the map can be set. This range is basically
defined either by the start orbit and the number of orbits, or by the start and stop dates. With the selection of either the radio
button ’Orbits’ or ’Dates’, the input fields for one of the choices are enables, and the other are disabled, respectively. Start orbit
and number of orbits are set in simple text fields, start and stop dates can be chosen via a calendar which pops up when the date
text field is clicked.
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Changing the inputs of start orbit/number of orbits, or start/stop date will invoke an immediate update of all these settings to
keep consistency every time. E.g., if the number of orbits is increased by one, the corresponding stop date will be updated and
increased by one orbital period.

Further options which can be set here are: ’Points per Orbit’ (which defines the temporal resolution), ’Show Orbits’ (which
defines the parts of orbits to be displayed, i.e., full, ascending or descending mode), and finally ’Show Orbit Numbers’. Selecting
this checkbox will result in additional labels in the map displaying the orbit numbers.

The graphical settings will be applied after a map update invoked by the ’Apply’ gearwheel icon.

5.2.1.12 Orbit Validation

Before a swath calculation will be performed after clicking the ’Apply’ gearwheel icon, a validation of the input values is
performed. The following rules are checked:

• None of the input fields in the Orbit toolwindow must be empty.

• All input fields (except date/time input) in the Orbit toolwindow must have number format.

• The MLST field must have time format hh:mm:ss and be within [00:00:00, 23:59:59].

• The Repeat Cycle must have integer format and be within [1,9999].

• A Cycle Length must exist for the given Repeat Cycle (i.e., the value must not remain empty after the Repeat Cycle was set).

• The Absolute Reference Orbit must have integer format and be within [1,99999].

• The Anx. Longitude must be within [0,360].

• The Start Orbit must have integer format and be within [1,99999].

• The Number of Orbits must have integer format and be within [1,99999].

• The Start Date must not be behind the Stop Date.

In POF/ROF mode, the settings in the dialog panel are validated against the validity range as defined in the POF/ROF file. The
application will not accept start or stop orbits beyond the scope of the POF/ROF file. The parameter validity range is displaced
in the Info Panel in this case.

Figure 5.4 shows an example for the violation of some rules listed above. In this case, a Validation Dialog appears after the
’Apply’ button was clicked, and the relevant input fields are highlighted in red.
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Figure 5.4: Invalid orbit definitions

Figure 5.5: Orbit Settings Validation Dialog
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5.2.2 Instruments Toolwindow

The Instruments toolwindow (Figure 5.6) is the GUI component in which the instrument settings (i.e. the scope of the instruments
of the selected spacecraft) of a scenario can be defined.

Figure 5.6: Instruments Toolwindow

5.2.2.1 Toolbar Elements

In the Instruments Panel Toolbar, the user can find three elements:

• Help Button: Invokes the Online Help for this toolwindow.

5.2.2.2 SCF File Selection

With the checkbox ’Use Mission Timelines File’, the user can decide if time segments from SCF files shall be considered for the
current scenario.

When the ’Use Mission Timelines File’ checkbox is selected, a non-editable text field and a ’Select SCF File’ button appear
underneath the checkbox. When the ’Select SCF File’ button is clicked, a directory chooser ’Open Directory with SCF Files’
appears. Its current directory is the Esov application directory (see Section 2.5.2). If a directory is selected and ’Open’ is clicked,
the directory chooser is closed, and the scope of all instruments for which SCF files exist in this directory is set to ’SCF’.

If the orbit settings in an SCF file are not consistent with the current orbit settings of the scenario, the former are adjusted, and
the user is warned about this in an info message dialog.

5.2.2.3 Instrument Scope Selection

Underneath the SCF selection elements, the Instruments toolwindow provides a table which lists all available instruments of
the selected spacecraft together with their current scope in the scenario. For each instrument, the scope can be selected from a
drop-down menu. It can take one of the following values:

• OFF: The instrument is not considered for swath calculations.

• ON: The instrument is considered for swath calculations. No filters are applied.

• ZONE: The instrument is considered for swath calculations. The computed swaths are filtered with regard to the zones defined
in the current scenario.

• STATION: The instrument is considered for swath calculations. The computed swaths are filtered with regard to the stations
defined in the current scenario. (This filter can only be applied to instruments with point swaths.)
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• SCF: If an SCF directory was chosen and ’Use Mission Timelines File’ is selected, an instrument with scope ’SCF’ is consid-
ered for swath calculations if an SCF file exists for this instrument. In this case, the information stored in this file is used for
the swath computation. If no SCF file exists, the instrument is not considered for swath calculations. The name convention for
the SCF file is ’instrumentname.scf’, e.g. ’MERIS.scf’.

• DRS: The instrument is considered for swath calculations. The computed swaths are filtered with regard to the visibility to a
DRS satellite. (This filter is only available when defined in the mission’s IDF file)

If the scope of an instrument has a value other than OFF, the corresponding table cell is highlighted in yellow.

5.2.2.4 Apply SZA

With the checkbox ’Apply SZA’, the user can decide if Sun Zenith Angle shall be applied in time segments computation for the
selected instruments in the current scenario.

When the ’Apply SZA’ checkbox is selected, an editable text field is enable next to the checkbox. The user can input a value in
degrees to consider as the Sun Zenith Angle. It should be noted that this functionality is available only for some mission. When
it is not available a warning message shall be displayed when computing segments.

5.2.3 Zones Toolwindow

The Zones toolwindow (Figure 5.7) is the GUI component in which zones can be added/removed to/from a scenario, and from
which zone list files can be saved/restored.

Figure 5.7: Zones Toolwindow

5.2.3.1 Toolbar Elements

In the Zones Toolwindow Toolbar (see Figure 5.8.) the user can find five elements:

• ’Open Zone List’ Button: If this button is clicked, an ’Open Zone List File’ dialog appears. Its current directory is the Esov
application directory. If a file is selected and ’Open’ is clicked, the file chooser is closed, and the zones from the selected zone
list file are loaded in the scenario and properly displayed in the zone list (see below).

• ’Save Zone List’ Button: If this button is clicked, a ’Save Zone List File’ dialog appears. Its current directory is the Esov
application directory. If a file name is set and ’Save’ is clicked, the file chooser is closed, and the zones from the zone list (see
below) are saved in the specified file.

• ’+’ Button (’Add Zone(s) to Scenario): If this button is clicked, the ’Add Zones’ dialog (see in detail Section 5.2.4) appears.

• ’-’ Button (’Remove Zone(s) from Scenario): If this button is clicked and a zone was selected before, this zone is removed
from the scenario and is not listed in the zone list (see below) any more. The map is updated accordingly.
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• Help Button: Invokes the Online Help for this toolwindow.

Note that no ’Apply’ icon is provided here since relevant changes related to this toolwindow are automatically applied.

Figure 5.8: Zones Toolwindow Toolbar

5.2.3.2 Zone List

The zone list is a tabular display of the zones which are defined in the current scenario. This table consists of four columns:

• Zone Computation: A gearwheel icon is displayed for each zone in the table. If the icon is clicked, it will accordingly disappear
in the table cell. This means that the zone is not considered for swath computations and is ommited in scenario. The map is
updated accordingly, zone filtering for this zone will not take place. To consider the zone again for swath computations and
draw the zone in scenario, you need to click in the gearwheel icon. Then it re-appears, and the map is updated accordingly,
now taking into account zone filtering for this zone again.

• Zone ID: The zone ID (unique identifier) is displayed in this column.

• Zone Description: The zone description is displayed in this column.

5.2.4 ’Add Zones’ Dialog

The Add Zones Dialog (see Figure 5.9) is a GUI component which zones can be selected to either add them to the current
scenario, or to a user database This dialog consists of a toolbar, a list for the selection of zones, and a button panel.

Figure 5.9: Add Zones Dialog

5.2.4.1 Toolbar Elements

In the Add Zones DialogToolbar (see Figure 5.10) the user can find three elements:
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• ’Copy system-defined zone into user database’ button: If this button is clicked, the zone database editor appears which is
needed to copy a system-defined zone into a user database. Only ’system-defined’ zones can be copied into a user database,
the copy is then per definition a ’user-defined’ zone. To avoid confusion, it is not possible to copy a ’scenario-defined’ zone (a
zone which had been added to the scenario) since a scenario-defined zone might have been a system-defined or a user-defined
zone before. Consequently, this button is only enabled when a ’system-defined’ zone (see below) was selected in the zone list.

• ’Hide system-defined zones’ button: If this toggle button is clicked, ’system-defined’ zones (which are all the zones coming
with the application) are shown/hidden in the zone list (see below).

• ’Help’ button: Invokes the Online Help for this dialog.

Figure 5.10: Add Zones Dialog Toolbar

5.2.4.2 Zone List

The zone list is a tabular display of the zones which are defined in the current scenario. This table consists of three columns:

• Type: An icon representing the zone type is displayed for each zone in the table. The three different types are:

– ’system-defined’ - a zone which comes with the application (within in a jar file)

– ’user-defined’ - a zone which was defined by the user with the zone database editor

– ’scenario-defined’ - a zone which is defined in the current scenario (therefore, listed in the Zones toolwindow)

The meaning is also illustrated by a tooltip if the mouse is moved onto an icon.

• Zone ID: The zone ID (unique identifier) is displayed in this column.

• Zone Description: The zone description is displayed in this column.

5.2.4.3 Buttons

In the Add Zones Dialog Button Panel the user can find two buttons:

• ’Add’ button: If this button is clicked after one or zones in the list were selected, these zones are added to the scenario. The
map is updated accordingly, and these zones are now listed in the Zones toolwindow.

• ’Close’ button: Invokes the Online Help for this dialog.

5.2.5 Stations Toolwindow

The Stations toolwindow (Figure 5.11) is the GUI component in which stations can be added/removed to/from a scenario, and
from which station list files can be saved/restored.
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Figure 5.11: Stations Toolwindow

5.2.5.1 Toolbar Elements

In the Stations Toolwindow Toolbar (see Figure 5.12.) the user can find five elements:

• ’Open Station List’ Button: If this button is clicked, an ’Open Station List File’ dialog appears. Its current directory is the Esov
application directory. If a file is selected and ’Open’ is clicked, the file chooser is closed, and the stations from the selected
station list file are loaded in the scenario and properly displayed in the station list (see below).

• ’Save Station List’ Button: If this button is clicked, a ’Save Station List File’ dialog appears. Its current directory is the Esov
application directory. If a file name is set and ’Save’ is clicked, the file chooser is closed, and the stations from the station list
(see below) are saved in the specified file.

• ’+’ Button (’Add Station(s) to Scenario): If this button is clicked, the ’Add Stations’ dialog (see in detail Section 5.2.6) appears.

• ’-’ Button (’Remove Station(s) from Scenario): If this button is clicked and a station was selected before, this station is removed
from the scenario and is not listed in the station list (see below) any more. The map is updated accordingly.

• Help Button: Invokes the Online Help for this toolwindow.

Note that no ’Apply’ icon is provided here since relevant changes related to this toolwindow are automatically applied.

Figure 5.12: Stations Toolwindow Toolbar

5.2.5.2 Station List

The station list is a tabular display of the stations which are defined in the current scenario. This table consists of four columns:

• Station Computation: A gearwheel icon is displayed for each station in the table. If the icon is clicked, it will accordingly
disappear in the table cell. This means that the station is not considered for swath computations and is ommited in scenario.
The map is updated accordingly, station filtering for this station will not take place. To consider the station again for swath
computations and draw the station in scenario, you need to click in the gearwheel icon. Then it re-appears, and the map is
updated accordingly, now taking into account station filtering for this station again.

• Station ID: The station ID (unique identifier) is displayed in this column.

• Station Description: The station description is displayed in this column.
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5.2.6 ’Add Stations’ Dialog

The Add Stations Dialog (see Figure 5.13.) is a GUI component which stations can be selected to either add them to the current
scenario, or to a user database This dialog consists of a toolbar, a list for the selection of stations, and a button panel.

Figure 5.13: Add Stations Dialog

5.2.6.1 Toolbar Elements

In the Add Stations DialogToolbar (see Figure 5.14.) the user can find three elements:

• ’Copy system-defined station into user database’ button: If this button is clicked, the station database editor appears which is
needed to copy a system-defined station into a user database. Only ’system-defined’ stations can be copied into a user database,
the copy is then per definition a ’user-defined’ station. To avoid confusion, it is not possible to copy a ’scenario-defined’ station
(a station which had been added to the scenario) since a scenario-defined station might have been a system-defined or a user-
defined station before. Consequently, this button is only enabled when a ’system-defined’ station (see below) was selected in
the station list.

• ’Hide system-defined stations’ button: If this toggle button is clicked, ’system-defined’ stations (which are all the stations
coming with the application) are shown/hidden in the station list (see below).

• ’Help’ button: Invokes the Online Help for this dialog.

Figure 5.14: Add Stations Dialog Toolbar

5.2.6.2 Station List

The station list is a tabular display of the stations which are defined in the current scenario. This table consists of three columns:
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• Type: An icon representing the station type is displayed for each station in the table. The three different types are:

– ’system-defined’ - a station which comes with the application (within in a jar file)

– ’user-defined’ - a station which was defined by the user with the station database editor

– ’scenario-defined’ - a station which is defined in the current scenario (therefore, listed in the Stations toolwindow)

The meaning is also illustrated by a tooltip if the mouse is moved onto an icon.

• Station ID: The station ID (unique identifier) is displayed in this column.

• Station Description: The station description is displayed in this column.

5.2.6.3 Buttons

In the Add Stations Dialog Button Panel the user can find two buttons:

• ’Add’ button: If this button is clicked after one or stations in the list were selected, these stations are added to the scenario.
The map is updated accordingly, and these stations are now listed in the Stations toolwindow.

• ’Close’ button: Invokes the Online Help for this dialog.

5.2.7 Sub-Satellite Point Toolwindow

The Sub-Satellite Point toolwindow (Figure 5.15) is the GUI component in which the user can configure the visualization of the
satellite position at a given time.

Figure 5.15: SSP Toolwindow

5.2.7.1 Toolbar Elements

In the SSP Panel Toolbar, the user can find one element:

• Help Button: Invokes the Online Help for this toolwindow.

5.2.7.2 SSP Selection

With the checkbox ’SSP Position’, the user can decide if the map showns the satellite position (marked with a satellite icon and
labelled with the corresponding date and time).

5.2.7.3 SSP Time Selection

When the ’SSP Position’ checkbox is selected the editable date/time field and the slider bar become active. Through these widgets
the user can select the epoch at which to display the satellite position. The acceptable values range between the orbit current time
interval. The display is automatically updated whenever the user edits the date filed or releases the slider after moving it.
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5.3 Opening a Scenario

To open an existing scenario, click ’Open’ in the File menu, or the button ’Open Scenario’ in the main toolbar. A file choose
dialog ’Open a Scenario’ appears (Figure 5.16). Select the scenario you want to open, and click ’Open’. The dialog ’Open a
Scenario’ is closed, and the scenario is opened in the main frame. Its name is given with full path in the frame title (Figure 5.17).

Figure 5.16: Open scenario dialog
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Figure 5.17: Opened scenario ’AEOLUS’

5.4 Saving a Scenario

To save a scenario, there are two entries in the File menu: ’Save’ and ’Save as...’. For the latter, there is an equivalent button in
the toolbar (see Section 4.2.3).

• Save As...: If the ’Save As...’ functionality is invoked, a save dialog ’Save Scenario’ appears (Figure 5.18). In this dialog,
type a filename and click ’Save’. If this file does not already exist, the ’Save’ dialog disappears, and the scenario is saved
in a scenario file with extension ’.xml’. If this scenario file already exists, you will be informed by a confirmation dialog
(Figure 5.19). In case you want to overwrite the existing scenario file, click ’OK’.

• Save: If the scenario has already been saved earlier, it will just be saved again under the existing item. If the scenario has not
yet been saved, a ’Save’ dialog appears, and the scenario can be saved as described above.
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Figure 5.18: Save scenario dialog

Figure 5.19: Save scenario confirmation dialog

5.5 Closing a Scenario

To close a scenario, click ’Close’ in the File menu. A confirmation dialog appears asking if the scenario shall be saved before
closing. (Figure 5.20). If ’Yes’ is clicked, the scenario will be saved as described in Section 5.4. If ’No’ is clicked, the scenario
will be closed immediately, and an empty main frame will remain. ’Cancel’ cancels the ’Close’ action.

Figure 5.20: Close scenario confirmation dialog
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5.6 Merging scenarios

It is now possible in Esov to merge several single scenarios to a ’multi-satellite’ scenario and to display this in a separate frame.
This functionality is described in detail in the ’Tools’ chapter (Section 8.2).

5.7 SCF Logical operations

It is now possible in Esov to perform logical operations over SCF files (and, or, not). The operations are allowed for instrument
files of the same mission. This functionality is described in detail in the ’Tools’ chapter (Section 8.3).

5.8 Shapefile to Zones

It is now possible in Esov to create a zone database definition file from a shapefile. This functionality is described in detail in the
’Tools’ chapter (Section 8.4).
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Chapter 6

Maps

All geographic information for a chosen Scenario such as satellite orbits, instrument swaths and station perimeters are presented
on a Map. When a Scenario is opened or newly created a new Map is created automatically. The automatically created Map can
be changed manually and be printed.

6.1 Changing a Map

A Map can be changed and customised by means of the Map Toolwindow and the Map Tools of the Main Toolbar.

6.1.1 Map Toolwindow

The Map Toolwindow can be accessed by selecting the Map from the Window menu item in theMain Menu. In the default
Toolwindow Layout the Map Toolwindow is also available from the Toolwindow Bar on the right side of the Main Window
frame. A typical instance of the Map Toolwindow is shown in the screenshot below.
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Figure 6.1: Map Toolwindow

The Toolwindow consists of basically three components: the Toolbar Elements, the Projection Settings Panel, and the Map
Legend Settings Panel.

6.1.1.1 Toolbar Elements

Selecting the toolbar element opens this Section of the Software User Manual.

6.1.1.2 Rectangular Projection

The rectangular projection is the default projection used and displayed when a new scenario has been set up (e.g., as shown in
Figure 5.2). For this projection, there is a corresponding projection panel in the Map Toolwindow as shown in Figure 6.2. It
contains the following elements to define the settings for this projection:

• ’Projection’ drop-down box: The projection (rectangular, azimuthal or gnomonic) can be selected.

• ’North Latitude’ text field: Defines the latitude of the upper map boundary.

• ’South Latitude’ text field: Defines the latitude of the lower map boundary.

• ’West Longitude’ text field: Defines the longitude of the left map boundary.
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• ’East Longitude’ text field: Defines the longitude of the right map boundary.

• ’World’ button: Resets the map boundaries to the default values (+90N, -90S, +180E, -180W), which is the same functionality
as for the ’World’ button in the main toolbar (Section 4.2.3).

Figure 6.2: Rectangular Projection Panel in the Map Toolwindow

6.1.1.3 Azimuthal Projection

The Azimuthal Projection is a projection on which the azimuths of all points are shown correctly with respect to the center.

As of version 1.6, changes to the projection are reflected in the map only when you select ’apply’ instead of immediately as in
earlier versions. With the default settings, a map in azimuthal projection looks as shown in Figure 6.3. For this projection, there
is a corresponding projection panel in the Map Toolwindow as shown in Figure 6.4. It contains the following elements to define
the settings for this projection:

• ’Center Longitude’ text field: Defines the center longitude value used in the projection formulas. This is also the longitude in
the center of the map display.

• ’Center Latitude’ text field: Defines the center latitude value used in the projection formulas. This is also the latitude in the
center of the map display.

• ’View Angle’ text field: Defines the latitude difference from the center of the map display to the upper/lower boundary (at zero
rotation angle). Projection parameters are not changed, i.e. no recomputation of the projection is required.

• ’Rotation Angle’ text field: The map is simply rotated by the given degree value. Projection parameters are not changed, i.e.
no recomputation of the projection is required.

• ’North Pole’ button: Resets the map parameters to the default values (Center Latitude +90deg., Center Longitude 0deg.,
View Angle 45deg., Rotation Angle 0deg.), which is the same functionality as for the ’World’ button in the main toolbar
(Section 4.2.3).

• ’South Pole’ button: Sets the map parameters to the default values, except that -90deg. instead of +90deg. is set for the Center
Latitude.
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Figure 6.3: Azimuthal Projection with default settings

Figure 6.4: Azimuthal and Gnomonic Projection Panel in the Map Toolwindow

6.1.1.4 Gnomonic Projection

The Gnomonic Projection is a projection in which great circles are mapped to straight lines. Since this projection sends two
antipodal points P_1 and P_2 to the same point P in the projection plane, it can only be used to project one hemisphere at a time.

As of version 1.6, changes to the projection are reflected in the map only when you select ’apply’ instead of immediately as
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in earlier versions. With the default settings, a map in gnomonic projection looks as in Figure 6.5. For this projection, the
corresponding projection panel looks the same as for the azimuthal projection (Figure 6.4).

Figure 6.5: Gnomonic Projection with default settings

6.1.1.5 Map Settings Validation

Map settings are only accepted by the application when they could be correctly validated. Validation is performed immediately
upon input. Failed validation leads to a red input field that cannot loose focus, so that you have to provide valid input in order to
apply these settings.

The following validation rules are checked:

• None of the input fields in the map toolwindow must be empty.

• All input fields must have number format.

• North and South Latitude must be within [-90, 90].

• North Latitude must be greater than South Latitude.

• West and East Longitude must be within [-180, 180].

• West and East Longitude must not be equal. (Note that it is possible to set the West Longitude > East Longitude, i.e. West
Longitude being positive and East Longitude being negative. In this case, the ’date line’ at +/- 180deg. will be included in the
map.)

• Center Latitude must be within [-90, 90].

• Center Longitude must be within [-180, 180].
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• View Angle must be within [0, 90] for Azimuthal Projection, and within [0, 90) for Gnomonic Projection.

• Rotation Angle must be within [-180, 180].

Figure 6.6 shows an example for the violation of some rules listed above.

Figure 6.6: Invalid map definitions

6.1.1.6 Map Legend Settings Panel

The Map Legend Settings Panel (Figure 6.7) provides the opportunity to

• Set a map background colour.

• Set a title for the map.

• Show or hide the map title.

• Show or hide a horizontal or vertical scale indicator. The indicator gives a rough estimate of the dimensions in the center of
the displayed image.

• Choose colours for the title and info text displayed on the map.

• Show or hide the title at the top and the info subtitle at the bottom of the map.

To apply these settings, the ’Apply’ gearwheel icon needs to be clicked.

Note that for the title and info colour, white/black/light gray/dark gray values work best, because the text is rendered with a glow
in the inverse colour in order to get a good contrast even on top of a background image. If you choose a very colourful display
this can lead to very ugly effects.

Figure 6.7: Map Legend Settings Panel
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6.1.2 Map Tools

Esov provides several tools to optimize the map view onto the current scenario (e.g., region of interest, swath details etc.). These
are:

• Zoom Tool

• Rotation

• World Display

• Distance Computation

which will be described in the following subsections. All the map tools are accessible from the main toolbar.

6.1.2.1 Zoom Tool

The zoom tool is generally invoked with the buttons:

• ’Zoom In’:

• ’Zoom Out’:

The way how the zoom mechanism is applied to the map depends on the current projection. To help aiming you can activate a
crosshair cursor for zooming in the user preferences dialog. (Section 12.4)

6.1.2.1.1 Rectangular Projection

• Zoom In: The zoom-in mechanism is enabled/disabled with the ’Zoom in’ toggle button If enabled, the mouse pointer symbol
is changed to a crosshair if moved over the map. The mechanism works then in two ways:

– "Click": If the user clicks into the map, it is zoomed in by a factor of two. The clicked point is taken as new center point of
the map. Also, the map is expanded on the map panel as far as possible (Figure 6.8).

– "Drag": If the user clicks into the map and moves the mouse with mouse button pressed, a rectangular area to be zoomed in
will be spawned and highlighted in dark green shade (Figure 6.9). The zoom will be performed when the mouse is released.
In the zoomed map, this rectangular area will be displayed as large as possible, i.e. fill the total horizontal or vertical range
of the map panel (depending on its current aspect ratio). In the other direction, the map map is again expanded on the map
panel as far as possible. An example is shown in Figure 6.10.

• Zoom Out: If the ’Zoom out’ button, the current map is zoomed out by a factor of two (inverse action to the ’Click’ zoom
in). If the maximum latitude/longitude ranges are already shown (as in the initial map or after clicking ’World Display’, see
below), this button has no effect.
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Figure 6.8: Zoomed map after clicking lat/lon point (0,0) in the initial map.

Figure 6.9: Dragged area to be zoomed in.
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Figure 6.10: Zoomed map after the drag shown in the figure above.

6.1.2.1.2 Azimuthal/Gnomonic Projection

• Zoom In: The zoom-in mechanism is also enabled/disabled with the ’Zoom in’ toggle button If enabled, the mouse pointer
symbol is changed to a crosshair if moved over the map. The mechanism works with the same approach as for Rectangular
projection.

• Zoom Out: If the ’Zoom out’ button is clicked, the current map is zoomed out in a way that the view angle is increased by a
value of 10 deg.. All other values remain unchanged. The maximum view angle is 90 deg..

• The crosshair cursor, configurable in the user preferences, is especially useful for zooming in azimuthal and gnomonic projec-
tion. (Section 12.4)

6.1.2.2 Rotation

The rotation tool is generally invoked with the buttons:

• ’Rotate Clockwise’:

• ’Rotate Counterclockwise’:

The rotation tool can only be used for the Azimuthal and Gnomonic projection. Each time a rotation button is clicked, a rotation
by an absolute value of 30deg. will be performed. Note that the ’Rotate Clockwise’ mechanism changes accordingly the ’Rotation
Angle’ value in the Map Settings Panel. An example for a clockwise rotation by 60 deg. in the Azimuthal projection is shown in
Figure 6.11.
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Figure 6.11: Azimuthal projection after clockwise rotation by 60 deg.

6.1.2.3 Center

The Center tool is generally invoked with the button:

• ’Center’:

The Center tool can be used for all projections. If clicked in the Rectangular projection, the map is centered with regard to the
longitude corresponding to the clicked point. If a zoom had been performed before, or if the tool is applied in the Azimuthal or
Gnomonic projection, the map is centered with regard to both longitude and latitude corresponding to the clicked point.

6.1.2.4 World Display

The World Display tool is generally invoked with the button:

• ’Show world’:

The World Display tool can be used for all projections. If clicked, the default map parameters (as described in Section 6.1.1) will
be set and applied for the current projection. However, note that the ’whole world’ can never be shown for the Azimuthal and
Gnomonic projection, since this is not possible for these projections.

6.1.2.5 Compute Distance

The Distance between two points tool is generally invoked with the button:
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• ’Compute distance’:

Selecting this tool activates the distance calculator. To compute the geodetic distance between two point first double click on the
initial point (marked by a pin) then click on the second point (marked by a different coloured pin). The distance label is shown
next to the target point.

6.2 Opening Multiple Maps

As of version 1.6 you can open multiple maps at the same time within one scenario. When you are working on a scenario, you
can either choose "New Map" from the "File" menu or right-click the title-tab of the current map and choose "New Map". This
will create a new map tab with the same settings as the current map, but a different title. Figure 6.12.

The name of the current map is also displayed in the title of the Map View, as you can now change the projection or the selected
region on each map separately. Figure 6.13

Many of the other settings of the application apply to all maps currently available, e.g. you will always see the same layers on all
maps. This feature is intended to provide multiple views for the same scenario, so all styles, layers, instruments etc. are always
available on all maps.

By dragging the maps title tab you can position maps so that multiple maps are shown at the same time. Be aware that this
results in longer rendering time (as each visible map has to be updated at the same time) and higher memory requirements. Also,
the orientation of maps is not reproduced when saving/opening a scenario. All maps are always stacked when a new scenario is
loaded, so that only one map is visible after loading a scenario.

Figure 6.12: Create a new map within the same scenario

Figure 6.13: The currently active map is shown in the Map View ("Map 2" in this example)

6.3 Printing a Map

The current map can be printed using the ’Print...’ menu entry in the ’File’ menu. A native printing standard dialog will then
displayed, guiding the user through the printing process. Note that only the map display itself will be printed, not the whole
application frame. Also note that on Mac OS X the printer driver may not allow to change the orientation so that, depending on
the map aspect ratio, not the whole space on the paper might be used. In this case, the user should export the map as GIF, PNG
or PDF file (see Section 11.2) and use printing capabilities of external applications.
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Chapter 7

Layer Management

7.1 The Layer Manager Toolwindow

The Layer Manager toolwindow (Figure 7.1) is the GUI component in which the visibility of the layers which can be displayed
in the Esov map is controlled.

Figure 7.1: Layer Manager Toolwindow

7.1.1 Toolbar Elements

In the Layer Manager Toolwindow Toolbar (see Figure 7.2) the user can find three elements:
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• Button ’Move up’: When this button is clicked, a selected layer in the layer manager tree will be moved up by one position.

• Button ’Move down’: When this button is clicked, a selected layer in the layer manager tree will be moved down by one
position.

• Help Button: Invokes the Online Help for this toolwindow.

Note that no ’Apply’ icon is provided here since relevant changes related to this toolwindow are automatically applied.

Figure 7.2: Layer Manager Toolwindow Toolbar

7.1.2 Layer Manager Tree

The Layer Manager Tree contains all layers which can basically be displayed in Esov. The tree is divided into three main
branches, the Geographical Layers Tree, Instruments Tree of the selected spacecraft the User Shapes Tree and the User Back-
ground Images. Each layer in the tree has an ’eye’ icon which serves as toggle button to show/hide the layer in the map. The tree
and its subtrees can be expanded (as inFigure 7.1) or collapsed (Figure 7.3).

Figure 7.3: Layer Manager Toolwindow with collapsed Layer Manager Tree

7.1.2.1 Geographical Layers Tree

The Geographical Layers Tree contains the following layers available in Esov:

• Background Image: NASA BlueMarble Bathymetry image of the world, providing a high-contrast view of continents, oceans
and polar regions for a better geographic orientation (Figure 7.4)

• Shore Lines / Political Borders: Layer providing polygons of shore lines and political borders for the globe. (Figure 7.5)

• Grid: Layer providing latitude/longitude grid lines. (Figure 7.6)

• Zones: Layer providing polygons of the zones defined in the current scenario. (Figure 7.7)

• Stations: Layer providing point symbols of the stations defined in the current scenario. (Figure 7.8)

• POIs: Layer providing Points of interest loaded in the current scenario. POI layer files can be imported through the menu ’File
->Import...’ (see Section 11.3.2 and Section 11.3.3)
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Figure 7.4: Esov map with ’Background Image’ layer shown, all other layers hidden.

Figure 7.5: As first figure, but ’Shore Lines / Political Borders’ layer also shown.
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Figure 7.6: As previous figure, but ’Grid’ layer also shown.

Figure 7.7: As previous figure, but ’Zones’ layer also shown (’Africa’ as example).
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Figure 7.8: As previous figure, but ’Stations’ layer also shown (’Hyderabad’ as example).

7.1.2.2 Instruments Tree

The Instruments Tree contains the spacecraft-specific layers available in Esov:

• ORBIT: The orbit layer of the selected spacecraft, represented by a line (’point swath’ type for every spacecraft, see below).

• Station Perimeters: The layer providing polygons of the perimeters of the stations defined in the current scenario. (Note that
these perimeters are spacecraft-dependent. Therefore, they are listed in the instrument tree and not handled as geographical
layer.)

• Instruments Subtree: The Instruments Tree contains the single layers representing the swaths of the different instruments as
computed for the current scenario. The swaths are represented either by a line (for ’point swath type’ instruments whose trace
on the ground is a one-dimensional line), or by a polygon (for ’line swath type’ and ’asar swath type’ instruments whose trace
on the ground is a two-dimensional area).

Figure 7.9 shows an example of all layers visible in an Esov map. For the ENVISAT spacecraft, a range of five orbits is shown
for the orbit layer and for the instruments MERIS (’line swath’ type with zone filter applied) and MWR (’point swath’ type with
station filter applied).
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Figure 7.9: Esov map with all layers shown. See text for details.

7.1.2.3 User Shapes Tree

The User Shapes tree contains user supplied overly shapes.

ESRI shape files can be imported through the menu ’File->Import...->Shapefile...’ (see Section 11.3.1). Shapes can also be added
to ESOV by simply copying ESRI Shape File format conformant files into a dedicated user shapes directory. This directory is
located in the Esov application directory (’user_shape_files’). ESOV detects and displays shapefiles that consist at least of:

• *.shp: contains the geometry data

• *.dbf: contains the attribute data

• *.shx: contains the connection between attributes and geometries

• *.prj: contains the projection information of the data

The ’user_shape_files’ directory is scanned once during the ESOV startup phase.

Initially, all User Shapes detected are set to ’invisible’; a User Shape can be switched to the visible state by clicking on the
’eye’-icon.

User Shape files are displayed in the User Shapes tree by using

• the type name(s) stored in the shape files or

• the shape file name without the file extension when no type names are available from the shape file.

7.1.2.4 User Background Images Tree

The User Background Images tree contains user supplied background images.

Specific background images are supplied ESOV by simply copying ESRI Shape File format in a dedicated user background
images directory. This directory is located in the Esov application directory (’user_background_images’). ESOV detects and
displays images that consist at least of:
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• *.jpg: contains the image itself

• *.prj: contains the projection information of the data

• *.wld: contains the location information of the data

The ’user_background_images’ directory is scanned once during the ESOV startup phase.

Initially, all User Background images detected are set to ’invisible’; a User Background Image can be switched to the visible
state by clicking on the ’eye’-icon.

User Background Images files are displayed in the User Background tree by using

• the image file name without the file extension

7.2 The Segments Toolwindow

The Segments Toolwindow Figure 7.11 is an informative toolwindow which lists the single segments computed for a certain
instrument for the current scenario. This toolwindow contains information only if an instrument (or the spacecraft’s orbit) has
been selected in the Layer Manager Tree, otherwise just a message ’no instrument selected’ is displayed (Figure 7.10)

Figure 7.10: Segments Toolwindow. No instrument selected.
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Figure 7.11: Segments Toolwindow with filled table (instrument MERIS selected).

7.2.1 Segments Table

The segments of the selected instrument are displayed in a table wth the following columns:

• Visibility: ’Eye’ icon serving as toggle button to show/hide a single segment in the map.

• Id: Segment index, starting with 0.

• Colour: Segment colour in the map.

• Start orbit: Start orbit of the segment

• Start second: Start time of the segment (relative time within the orbit, given in seconds)

• Start UTC: UTC start time of the segment

• Stop orbit: Stop orbit of the segment

• Stop second: Stop time of the segment (relative time within the orbit, given in seconds)

• Stop UTC: UTC stop time of the segment

• Zone: Identifier of the zone (if scope ZONE/MULTIZONE is applied to the instrument)

• Station: Identifier of the ground station (if scope STATION/MULTISATION is applied to the instrument)

• Geo: Longitude of the GEO satellite (if scope DRS is applied to the ORBIT, being DRS visibility enabled in IDF)

The Segments Table provides the following functionalities:

• Single segments can be shown/hidden with the ’Visibility’ toggle button (’eye’ icon) (Figure 7.12).

• Single segments can be selected to set their specific style in the style toolwindow (see Section 7.3). Multiple selection is also
possible.
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Figure 7.12: Segments Toolwindow: Visibility toggle - second segment hidden.

7.3 The Style Toolwindow

The management of layer style properties is handled by a ’Style’ toolwindow (Figure 7.13). In this toolwindow, properties for
distinct layers are listed in a table, together with suitable editors to change each property. Furthermore, it provides a description
area providing a brief description of a selected property.

7.3.1 Toolbar Elements

The Style Toolwindow Toolbar contains some special elements which are useful in particular for the property editors. In the
Style Toolwindow Toolbar (see Figure 7.14) the user can find the following elements:

• ’Categorized’: When this toggle button is selected, the style properties are displayed in a categorzed tree. (Note that currently
only one category, ’Style Info’, is used.)

• ’Alphabetic’:When this toggle button is selected, the style properties are displayed alphabetically.

• Show/Hide Description Area: When this toggle button is selected/deselected, the description area underneath the style info is
shown/hidden.

• Expand: When this toggle button is selected, the tree in the ’Categorized’ view is expanded.

• Collapse: When this toggle button is selected, the tree in the ’Categorized’ view is collapsed.

• Help Button: Invokes the Online Help for this toolwindow.

Note that no ’Apply’ icon is provided here since relevant changes related to this toolwindow are automatically applied.

Figure 7.13: Style Toolwindow

Figure 7.14: Style Toolwindow Toolbar
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7.3.2 Style Editors

The styles of the different layers used in Esov are controlled with specific editors which provide a user-friendly way to set the
single layer properties. If a layer is selected in the layer manager, the corresponding editor is displayed in the Style Toolwindow.

7.3.2.1 Default Style Editor

A ’default style editor’ (Figure 7.13) is displayed when a root or subroot node is selected in the Layer Manager (’Geographical
Layers’, spacecraft name or ’Instruments’). It consists of one single property ’opacity’. This editor is usable in principle,
however, changes have no effect. The opacity needs to be set separately for each single layer. The ’default style editor’ is also
displayed for the background image layer. This layer has a fix opacity of 100 percent.

7.3.2.2 Shoreline Style Editor

When the layer ’Shorelines / Political Borders’ is selected, the Shoreline Style Editor is displayed (Figure 7.17. With this editor,
the following properties can be configured:

• Opacity: The opacity of the polygons can be set on a scale from 0 to 100 percent. (Figure 7.17) The default value is ’50’.

Note that the appearance of the slider bar is a bit platform-dependent, i.e. the percentage scale might not be fully visible on
every platform. In this case, the user can (as for all table rows in the Style Toolwindow) manually change row height by
left-click with the mouse on the horizontal row boundaries, and drag them up/down.

• Color: The color of the polygons can be set manually by typing the hexadecimal value of the color (if known) in the right
table cell of the ’Color’ row, or with a separate color editor which is invoked by left-click in the table cell. This color editor
provides a variety of predefined colors, and, by clicking ’More Colors’, also options to define new colors ( Figure 7.15 and
(Figure 7.16). The default value is ’green’ (#00FF00).

If the color was set by its hexadecimal value, the user needs to click into the left table column to finally set the value. A color
choice from the color editor will be automatically applied, and the map is updated accordingly.

Figure 7.15: Style Toolwindow: Color Editor
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Figure 7.16: Style Toolwindow: Color Editor with option to define more colors

Figure 7.17: Style Editor for Shorelines / Political Borders

7.3.2.3 Grid Style Editor

When the layer ’Grid’ is selected, the Grid Style Editor is displayed (Figure 7.21. With this editor, the following properties can
be configured:

• Opacity: as described for ’Shorelines / Political Borders’.

• Resolution: The resolution of the latitude/longitude grid lines can be selected from a drop-down list in the ’Resolution’ table
row, (Figure 7.18) which becomes visible by clicking into the right table cell of the ’Resolution’ row. Possible values are 30,
15, 10, 5, 1, 0.1 and 0.01 degrees. After selection of the value, the map is updated accordingly. The default value is ’30’.
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Figure 7.18: Grid Style Editor: Resolution Selection

• Color: as described for ’Shorelines / Political Borders’. The default value is ’white’ (#FFFFFF).

• Style: The line style of the latitude/longitude grid lines can be selected from a drop-down list in the ’Style’ table row, which
becomes visible by clicking into the right table cell of the ’Style’ row (Figure 7.19). Possible values are ’Solid’, ’Dashed’ and
’Dotted’. After selection of the value, the map is updated accordingly. The default value is ’Solid’.

Figure 7.19: Grid Style Editor: Style Selection

• Axis Labels: The option if axis labels should be shown with the grid can be selected from a drop-down list in the ’Axis Labels’
table row, which becomes visible by clicking into the right table cell of the ’Axis Labels’ row (Figure 7.20). Possible values
are ’Yes’ and ’No’. After selection of the value, the map is updated accordingly. The default value is ’Yes’.

Figure 7.20: Grid Style Editor: Label Option Selection

Figure 7.21: Grid Style Editor

7.3.2.4 Zone Style Editor

When the layer ’Zone’ is selected, the Zone Style Editor is displayed (Figure 7.22. With this editor, the following properties can
be configured:
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• Opacity: as described for ’Shorelines / Political Borders’.

• Color: as described for ’Shorelines / Political Borders’. The default value is ’red’ (#FF0000).

• Style: as described for ’Grid’.

• Filled: The option if the zone area should be filled with the chosen color can be selected from a drop-down list in the ’Filled’
table row, which becomes visible by clicking into the right table cell of the ’Filled’ row. Possible values are ’Yes’ and ’No’.
Note that the zone can only be filled if ’Solid’ was chosen as line style before. After selection of the value, the map is updated
accordingly. The default value is ’No’.

• Show Labels: The option if a label should be shown for the zone can be selected from a drop-down list in the ’Label’ table
row, which becomes visible by clicking into the right table cell of the ’Show Labels’ row. Possible values are ’Yes’ and ’No’.
After selection of the value, the map is updated accordingly. The default value is ’No’.

• Label Size: The font size of the zone labels must be set manually in the the right table cell of the ’Size’ row. Valid numbers
are positive integers. Floats will be truncated, negative values be interpreted as their absolute value. The ’zero’ is accepted, the
labels will disappear in this case. Invalid input (such as characters) will be ignored. After setting a valid number, the map is
updated accordingly. The default value is ’12’.

Figure 7.22: Zone Style Editor

7.3.2.5 Station Style Editor

When the layer ’Station’ is selected, the Station Style Editor is displayed (Figure 7.24. With this editor, the following properties
can be configured:

• Opacity: as described for ’Shorelines / Political Borders’.

• Color: as described for ’Shorelines / Political Borders’. The selected color is applied to the station point symbol in this case.
The default value is ’magenta’ (#FF00FF).

• Style: The style of the station symbols can be selected from a drop-down list in the ’Style’ table row, which becomes visible by
clicking into the right table cell of the ’Style’ row. Possible values are ’Circular’, ’Quadratic’ , ’Triangular’ , ’Arrow’ , ’Cross’
, ’Star’ and ’X’ (Figure 7.23). After selection of the value, the map is updated accordingly. The default value is ’Circular’.
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Figure 7.23: Station Style Editor: Style Selection

• Size: The size of the station symbols must be set manually in the the right table cell of the ’Size’ row. Valid numbers are
positive integers. Floats will be truncated, negative values be interpreted as their absolute value. The ’zero’ is accepted, the
symbols will disappear in this case. Invalid input (such as characters) will be ignored. After setting a valid number, the map is
updated accordingly. The default value is ’7’. Note that also the font size of the station labels (if displayed, see below) will be
adjusted proportionally to this size.

• Show Labels: The option if a label should be shown with the station symbols can be selected from a drop-down list in the
’Show Labels’ table row, which becomes visible by clicking into the right table cell of the ’Show Labels’ row. Possible values
are ’Yes’ and ’No’. After selection of the value, the map is updated accordingly. The default value is ’No’.

Figure 7.24: Station Style Editor

7.3.2.6 Station Perimeter Style Editor

When the layer ’Station Perimeter’ is selected, the Station Perimeter Style Editor is displayed (Figure 7.25. A station perimeter
can in principle regarded as a geographical area. Therefore, with this editor, the same properties as for zones can be configured:

• Opacity: as described for ’Shorelines / Political Borders’.

• Color: as described for ’Shorelines / Political Borders’. The default value is a dark yellow (#FFC800).

• Style: as described for ’Grid’.

• Filled: as described for ’Zones’. (Note that the filled area for stations close to a pole (e.g., Svalbard) may appear incomplete
in the Rectangular projection. In this case, the user should switch to the Azimuthal or Gnomonic projection to obtain a proper
image.)

• Show Topocentric: show topocentric elevation contour lines for all stations. (Figure 7.26)

• Elev. Angle: Elevation angle steps for the topocentric contour lines. (Figure 7.26)
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Figure 7.25: Station Perimeter Style Editor

Figure 7.26: Showing a station’s topocentric elevation in steps of 30 deg.

7.3.2.7 Swath Style Editor

When a specific instrument layer or ’ORBIT’ is selected, the Swath Style Editor is displayed (Figure 7.29. With this editor, the
following properties can be configured:

• Opacity: as described for ’Shorelines / Political Borders’.

• Color: as described for ’Shorelines / Political Borders’. The default value for ORBIT is ’white’ (#FFFFFF). The single
instruments of the different spacecrafts have their own default values.

• Style (for a ’point swath’): The style of the swath can be selected from a drop-down list in the ’Style’ table row, which becomes
visible by clicking into the right table cell of the ’Style’ row. Possible values for a point swath are ’Solid’, ’Dashed’ , ’Dotted’ ,
and ’Timeline’ (Figure 7.27). The ’Timeline’ style is a special solid style containing tickmarks showing the temporal resolution
(’points per orbit’) used for the swath computation. After selection of the value, the map is updated accordingly. The default
value is ’Solid’.
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Figure 7.27: Station Style Editor: Style Selection

• Style (for ’line swath’ and ’asar’ swath): The style of the swath can be selected from a drop-down list in the ’Style’ table
row, which becomes visible by clicking into the right table cell of the ’Style’ row. Possible values for a line swath or an asar
swath are ’Solid’ and ’Hollow’ (Figure 7.28). After selection of the value, the map is updated accordingly. The default value
is ’Hollow’.

Figure 7.28: Station Style Editor: Style Selection

Figure 7.29: Swath Style Editor

It is also possible to set the swath style not only for a whole instrument layer by selection of the layer in the Layer Manager, but
also for single segments by (multi-)selecting specific segments in the Segments Toolwindow ( Figure 7.30 and Figure 7.31).

Figure 7.30: Segments Toolwindow: Individual Color Selection
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Figure 7.31: MERIS Swaths with individual colors

Note that single segments are always set back to the instrument’s default style if a new swath calculation is performed.
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Chapter 8

Tools

The latest version of Esov offers two new key functionalities which are provided as distinct tools and which are available from
the Tools menu of the main menu bar. These functionalities are the Azimuth / Elevation 2D Plot, the merge of several single
scenarios to a ’multi-satellite’ scenario, logical operations over SCF files and transformation of shapefiles to Zone files.

8.1 Azimuth / Elevation 2D Plot

For a given single location (center of system-defined zone or user-defined point) and time range, the UTC time (the x axis),
topocentric azimuth and elevation towards the satellite are computed and can be displayed for each segment in a 2D graph.

To select the location, click ’Azimuth / Elevation 2D Plot...’ in the ’Tools’ menu. (Figure 8.1). A dialog ’Azimuth / Elevation 2D
Plot...’ appears (Figure 8.2), in which the location coordinates must be selected. After selection, the dialog ’Azimuth / Elevation
2D Plot...’ is closed, and the computed azimuth/elevation plot is opened in a separate window (Figure 8.6).

Figure 8.1: ’Azimuth / Elevation 2D Plot...’ entry in ’Tools’ menu

8.1.1 The Location Selection dialog

The LocationSelection dialog (Figure 8.2) is the GUI component in which the location for the azimuth/elevation plot must be
selected.
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Figure 8.2: Selection dialog for the location for azimuth/elevation plot

8.1.1.1 Toolbar Elements

In the Selection dialog for the location, the user can find two elements:

• Help Button: Invokes the Online Help for this toolwindow.

• ’Apply’ gearwheel icon: Invokes a validation of format and consistence of the toolwindow input elements. If the input is valid,
the plot computation based on this input is performed.

8.1.1.2 Location Selection Panel

With the radio buttons ’Select Station Location’ or ’Select Point’, the user can decide if he wants to use the location of a system-
defined groundstation, or if he wants to define an own location.

If the radio button ’Select Station Location’ is selected: From the drop down list ’Select Station Location’, the user can select
one of the system-defined stations. The center coordinates of this groundstation are considered for the plot computation.

If the radio button ’Select Point’ is selected: In the ’Point Definition’ subpanel, the user can set the coordinates of an own
location. These coordinates (longitude, latitude, altitude) can be set either manually by typing into the corresponding textfields,
or in ’graphical editing’ mode from direct selection in the current map.

For usage of the ’graphical editing’ mode (see Figure 8.3), the following functionalities are provided by buttons:

• ’Paint brush’ button: A toggle button which, if activated, invokes the ’graphical editing’ mode, and vice versa. In ’graphical
editing’ mode, the location selection dialog is set to ’unmodal’, and the user can set a location in the map by clicking with the
mouse, indicated by a crosshair symbol. The coordinates of this point will automatically be set in the text fields of the Point
Definition subpanel.

• ’Hand brush’ button: resets location in the textfields (i.e. sets all to 0.0). This button is enabled only if ’graphical editing’
mode is not active.

• ’Refresh’ button: synchronizes the point definition in the textfields with the drawing in the map (i.e. applies changes made in
non-graphical editing mode) This button is enabled only if ’graphical editing’ mode is not active.

Copyright © 2008 - 2020 ESA



Esov Software User Manual 67 / 145

Figure 8.3: Selection dialog for the location for azimuth/elevation plot: graphical editing mode active

If the coordinates defined by the user are valid, they are considered for the plot computation after clicking the gearwheel icon.
Otherwise, the user is notified that the validation was not successful (see Figure 8.4 and Figure 8.5). Otherwise

With the text field ’Time Step’, the user defines the temporal resolution to be used for the azimuth/elevation time series compu-
tation.

Figure 8.4: Selection dialog for the location for azimuth/elevation plot: Invalid longitude coordinate
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Figure 8.5: Selection for the location for azimuth/elevation plot: Validation Info dialog

8.1.2 The Azimuth / Elevation 2D Plot dialog

The Azimuth / Elevation 2D Plot dialog (Figure 8.6) is the GUI component in which the result of the azimuth/elevation time
series computation is displayed. Besides the graphical display, a navigation panel with buttons to switch between the plots for
the different segments, and a tabular results overview are provided in this dialog.

Figure 8.6: Azimuth / Elevation 2D Plot dialog
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8.1.2.1 Toolbar Elements

The functionalities of this dialog do not require any toolbar elements.

8.1.2.2 Graphics Panel

In the graphics panel, the result of the azimuth/elevation time series computation is displayed for the selected segment. The
segment selection can be changed from the navigation panel (see below). There are two y-axes: azimuth (left) with default range
0-360 deg., and elevation (right) with default ragne 0-90 deg.

Various options to customize the graphics are provided:

• It is possible to zoom into a plot area of interest by dragging a zoom rectangle with the left mouse button pressed ( Figure 8.8
andFigure 8.9).

• Plot settings menu: This menu is invoked by right-clicking with the mouse into the graphics (Figure 8.7). The menu provides
the following entries:

– ’Properties...’: If this entry is selected, a separate ’Chart Properties’ dialog is opened (Figure 8.10). From this dialog, various
plot settings (such as labels, fonts, colours etc.) can be adjusted. (A full description of all these settings is beyond the scope of
this SUM. For more details, please refer to the documentation of the original JFreeChart software (www.jfree.org/jfreechart)
which is used by Esov as 3rd party technology. However, most of the settings are rather self-explaining and easy to use.)

– ’Copy’: This option is unclear and seems to have no effect.

– ’Save as...’: It is possible to save the graphics as png file. If this entry is selected, a standard file save dialog is opened, and
the user can select a location to save the graphics.

– ’Print...’: It is possible to print the graphics. If this entry is selected, a standard file save dialog is opened, and the user can
select a location to save the graphics.

– ’Zoom In’: With this option it is possible to zoom into the center of the plot by a factor of two. With the options from the
submenu (Figure 8.11), it can be chosen if range axis, domain axis, or both axes shall be considered.

– ’Zoom Out’: With this option it is possible to zoom out from the center of the plot by a factor of two. With the options from
the submenu, it can be chosen if range axis, domain axis, or both axes shall be considered.

– ’Auto Range’: With this option, the range of the plot can be adjusted to the minima/maxima of the data sets. by a factor of
two. With the options from the submenu, it can be chosen if range axis, domain axis, or both axes shall be considered.

Figure 8.7: Plot customize menu
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Figure 8.8: Dragged zoom selection rectangle

Figure 8.9: Zoom selection result
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Figure 8.10: ’Chart Properties’ dialog

Figure 8.11: Zoom options submenu in Plot settings menu

8.1.2.3 Navigation Panel

With the four buttons in the subpanel ’Segments navigation’, the user can navigate through the result segments to the particular
segment he wants to see in the graphics. The buttons are self-explaining from their icons:

• ’First’ button: if clicked, the first segment of the result set is displayed

• ’Backward’ button: if clicked, the segment with the previous index in the result set is displayed

• ’Forward’ button: if clicked, the segment with the next index in the result set is displayed

• ’Last’ button: if clicked, the last segment of the result set is displayed

If a segment is marked as ’invisible’ in the Segments results table (see below), it is skipped and will not be displayed.
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8.1.2.4 Segments results table

The segment results table gives an overview of the segments for which the azimuth/elevation computation results can be dis-
played. This table is similar to the one in the segments toolwindow (see Section 7.2). The following columns are displayed:

• Segment index, starting with zero

• Visibility: ’Eye’ icon serving as toggle button to show/hide a single segment in the map.

• Colour Az: Azimuth colour in the graphics.

• Colour El: Elevation colour in the graphics.

• Colour M: Elevation Mask colour in the graphics.

• Start orbit: Start orbit of the segment

• Start second: Start time of the segment (relative time within the orbit, given in seconds)

• Start UTC: UTC start time of the segment

• Stop orbit: Stop orbit of the segment

• Stop second: Stop time of the segment (relative time within the orbit, given in seconds)

• Stop UTC: UTC stop time of the segment

The segments results table provides the following functionalities:

• Single segments can be shown/hidden with the ’Visibility’ toggle button.

• The colour of azimuth or elevation curve can be selected with a colour editor (Figure 8.12)

Figure 8.12: Colour editor for azimuth/elevation curves

If there are no segments to be displayed, the graphics and the results table remain empty, and an appropriate message is displayed
instead (Figure 8.13)
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Figure 8.13: No segments to be displayed in Azimuth / Elevation 2D Plot

8.1.2.5 Export Segments

The Azimuth / Elevation 2D Plot Dialog allows exporting the computed segments to file. Pressing the ’Export’ button (Figure 8.6)
the user is presented with a dialog requesting a file where to save the segment exportation.

8.2 Merging scenarios

To merge two or more scenarios, click ’Merge Scenarios...’ in the ’Tools’ menu (Figure 8.14). A dialog ’Merge Scenarios’
appears (Figure 8.15), in which the scenarios to be merged and the map settings to be used must be selected. After selection, the
dialog ’Merge Scenarios...’ is closed, and the resulting merged scenario is opened in a separate frame (Figure 8.17). This frame
basically looks like the one for a single scenario but has the following important differences:

• A merged scenario is meant to be a pure ’graphical’ result and cannot be saved/reloaded. Therefore, in the ’Files’ menu, only
the following functionalities are available/enabled:

– Print...

– Export Image...

Also, the main toolbar does not contain the symbols for ’New scenario’, ’Open scenario’ and ’Save scenario’.

• There are no ’Edit’ and ’Tools’ menus
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• The ’Window’ menu has an additional entry for the ’Time Control’ toolwindow

• The subtitle consists of one line for each of the single scenarios being merged

• The Layer Manager toolwindow also contains tree nodes for each of the single scenarios being merged. Also note that the
zones and stations are scenario dependent and therefore appear under the distinct scenario tree nodes.

Figure 8.14: ’Merge Scenarios’ in Tools menu

8.2.1 The Scenario Selection dialog

The Scenario Selection dialog (Figure 8.15) is the GUI component in which the scenarios to be merged can be selected.

Figure 8.15: Selection dialog for merging scenarios

8.2.1.1 Toolbar Elements

In the Selection dialog for merging scenario, the user can find as only element:

• Help Button: Invokes the Online Help for this toolwindow.

8.2.1.2 Scenario Selection Panel

From the drop down list ’Select Scenario’, the user can (by multiple selection) define the scenarios to be merged. The list contains
the spacecrafts corresponding to the currently open scenarios. At least two scenarios (spacecrafts) must be selected, otherwise
the user will be warned by an info dialog (Figure 8.16).

With the ’Import Map Settings’ radio buttons, the map settings to use for the merged scenario can be selected as either the default
ones, or the ones from one of the single scenarios, also represented by a drop-down list with the corresponding spacecrafts.
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Figure 8.16: Info dialog: scenarios to be merged not selected

Figure 8.17: Window displaying a merged scenario for the spacecrafts ENVISAT, CRYOSAT and ADM

8.2.2 The Time Control Toolwindow

The Time Control toolwindow (Figure 8.18) is the GUI component in which the time intervals for the merged scenario can be
defined. It is possible to define a common time interval for all single scenarios being merged, or different time intervals for each
of the single scenarios.
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Figure 8.18: Time Control Toolwindow

8.2.2.1 Toolbar Elements

In the Time Control Toolwindow Main Toolbar, the user can find two elements:

• Help Button: Invokes the Online Help for this toolwindow.

• ’Apply’ gearwheel icon: An update of the merged scenario display is performed according to the changes of the time intervals.

8.2.2.2 Time Interval Settings Panel

With the radio buttons ’Set Time Interval For Each Scenario’ or ’Set Common Time Interval’, the user can decide whether he
wants to define a common time interval for all single scenarios being merged, or different time intervals for each of the single
scenarios.

With the ’Select Scenario’ drop-down list, the user can select one of the single scenarios and set a distinct time interval from the
calendar combo box (see Section 5.2.1.11). The ’Select Scenario’ drop-down list and the the calendar combo boxes below are
enabled only if the radio button ’Set Time Interval For Each Scenario’ is selected.

In the same way, the user can select a common time interval if the radio button ’Set Common Time Interval’ is selected.

8.3 SCF Logical Operations

To perform logical operations over SCF files click ’SCF Logical Operations...’ in the ’Tools’ menu. A dialog ’SCF Logical
Operations’ appears (Figure 8.19), in which the files to be operated on and the operation to perform must be selected.
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Figure 8.19: SCF logical operations dialog

With the buttons in the dialog, the user can indicate:

• ’Scf File 1’ button: if clicked, an open file dialog is opened to select the first SCF file

• ’Scf File 2’ button: if clicked, an open file dialog is opened to select the second SCF file

• ’Output Scf File’ button: if clicked, an open file dialog is opened to select the folder where the resulting SCF file(s) shall be
stored

• ’Or operation’ button: if clicked, the OR logical operation shall be performed over the two selected files

• ’And operation’ button: if clicked, the AND logical operation shall be performed over the two selected files

• ’Not operation’ button: if clicked, the NOT logical operation shall be performed over the first selected file.

8.4 Shapefile to Zone transformation

To convert a shapefile to a zone database definition file click ’Shapefile to Zone...’ in the ’Tools’ menu. A dialog ’Shapefile to
Zones’ appears (Figure 8.20), in which the conversion operation shall be configured.

Figure 8.20: Shapefile to Zones tool dialog

With the buttons in the dialog, the user can indicate:
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• ’Shapefile’ button: if clicked, an open file dialog is opened to select the shapefile to convert

• ’Output Zone File’ button: if clicked, an open file dialog is opened to select the folder where the resulting zone database file
shall be stored

• ’Coordinates step’ text field: if filled, shall contain the number of points defining the step to iterate on the shapefile points to
convert.

• ’Apply’ button: if clicked, the conversion shall occur.
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Chapter 9

Zone Databases

9.1 What is a Zone Database?

A zone database is basically a xml-formatted file containing relevant information on zones which can be considered for an Esov
scenario. Zone databases are divided into

• System-defined zone database: In Esov, there is exactly one system-defined zone database. The zones in this database cannot
be changed or deleted, nor can new zones be added. The system-defined zone database is also an xml-formatted file, but it is
’hidden’ in a jar archive which comes with the application. For the Esov user, there is no need to access this file directly. The
zones stored in this database become visible as ’system-defined’ zones in the ’Add Zones’ toolwindow. These zones can be
copied into a user-defined database (see Section 5.2.4).

• User-defined zone database: In Esov, there is a default user-defined zone database (’defaultzones.dbf’) in the Esov application
directory. If not existing, this file is created when Esov is started. Zones in this database can be edited or deleted, and new
zones can be added with the ESOV Zone Database Editor (see below). Also, any other valid zone database file can be set as
user-defined zone database. However, a zone database file other than the default file must have been created externally. It is
not possible to create an ’empty’ user-defined zone database from Esov.

9.2 Zone Database Editor

The ESOV Zone Database Editor can be activated by selecting ’Zone Database...’ in the Edit menu of the main menu bar.
A modal dialog ’Zone Database Editor’ appears (Figure 9.1). This window basically allows the user to define a database of
’user-defined’ zones, view the zones, and create, edit or delete zones.

Copyright © 2008 - 2020 ESA



Esov Software User Manual 80 / 145

Figure 9.1: Zone Database Editor

9.2.1 Database Selection Panel

In the Database Selection Panel (see Figure 9.2), the user can switch between the default user-defined zone database (default
selection when the Zone Database Editor is initially opened), and the definition of an ’Other User Database’.

• ’Other User Database’: If this button is selected, a non-editable text field and a ’Select User Database...’ button appear
on its right. When this button is clicked, an ’Open Database’ dialog appears. Its current directory is the Esov application
directory. The files available in this folder are database files with the extension ’.dbf’. (Note that also station database files (see
Chapter 10) which have the same extension are listed here. If the user accidentally selects a station database instead of a zone
database, an error dialog appears that this file could not be read (Figure 9.3)).
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Figure 9.2: Zone Database Selection Panel

Figure 9.3: Error dialog: Wrong database type

9.2.2 Zone List Panel

In the Zone List (Figure 9.4), the zones included in the selected user database are listed with their ID and Description. If a zone
is selected in this table, it can be changed or deleted (see Section 9.2.4).

Figure 9.4: Zone List Panel
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9.2.3 Zone Definition Panel

In the Zone Definition Panel (Figure 9.5), the user can define new zones or edit existing zone.

Figure 9.5: Zone Definition Panel

This panel consists of three subpanels:

• Header: In this subpanel, the zone header information is defined. The parameters are:

– Zone ID (entry required)

– Zone Description (entry required)

– Zone Surface (entry optional)

– Zone Creator (entry optional)

– Zone Type (Polygon/Circular toggle button)

• Circular: If the zone type has been set to ’Circular’ in the header panel, the specification for a circular zone is defined in this
subpanel. The parameters are:

– Center Longitude (entry required)

– Center Latitude (entry required)
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– Diameter (entry required)

– Functionalities provided by buttons:

* ’Paint brush’ button: A toggle button to activate ’graphical editing’ mode (same as for ’Polygon’ panel). - Clicking in the
map will create a new center point of a circular zone and display its coordinated in the (disabled) text fields. - Clicking
into the square symbol of the center point and dragging it with the mouse button kept pressed will define the diameter.
For convenience, a green "radius line", together with the current value of the radius dragged, are displayed in the map.
(Figure 9.6) If the mouse is released, the circular zone will be drawn (Figure 9.7), and the diameter value in the text field
is updated.

* ’Hand brush’ button: resets all text fields to 0.0 while in ’text field editing’ mode

* ’Refresh’ button: synchronizes the text fields with the drawing in the map (i.e. applies changes made in ’text field editing’
mode)

If the zone type has been set to ’Polygon’ in the header panel, the ’Circular’ subpanel is disabled.

Figure 9.6: Creating a circular zone in ’graphical editing’ mode.
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Figure 9.7: Circular zone created in ’graphical editing’ mode.

• Polygon: If the zone type has been set to ’Polygon’ in the header panel, the specification for a polygon zone is defined in this
subpanel. A zone polygon is defined by its points (latitude/longitude) which are set in the Point List. New points (0.0, 0.0) can
be added with the ’+’ button or in the graphical editing mode (as further explained below). Points can be edited by clicking
into the specific table cell. (Note that you have to click once again into another, arbitrary table cell to complete cell editing and
apply the changed value.)

The following functionalities are provided by buttons:

– ’Paint brush’ button: A toggle button (like for the zoom tool). If activated, the ’graphical editing’ mode is invoked. In this
mode, the zone database dialog is set to ’unmodal’, and you can create a polygon in the map with the mouse, indicated by a
crosshair symbol. (To avoid bringing the application into a weird state while editing in this mode, all other components of
the zone database editor (except help/close buttons) as well as of the map settings frame are disabled). - Clicking in the map
will create a new point and add it to the polygon point list, which is automatically updated. - An existing point can be moved
by clicking into its square symbol and dragging it with the mouse button kept pressed. The point is continuously updated in
the point list. - To delete an existing point, you have to leave the graphical mode (click toggle button) and to remove it from
the point list (’minus’ button). For convenience, the point indices in the table are also displayed in the map (Figure 9.8).

– ’Circular’button: flip point list while in ’tabular editing’ mode. It reverses the order of the zone points list to define the
interior of a given zone instead of the exterior (or the other way around)

– ’Plus’ and ’Pinus’ button: add/remove points from the list while in ’tabular editing’ mode.

– ’Hand brush’ button: remove all points from the list while in ’tabular editing’ mode

– ’Refresh’ button: synchronizes the point list table with the drawing in the map (i.e. applies changes made in ’tabular editing’
mode)

If the zone type has been set to ’Circular’ in the header panel, the ’Polygon’ subpanel is disabled.
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Figure 9.8: Polygon zone created in ’graphical editing’ mode.

9.2.4 Editor Elements

Underneath the Zone List and the Zone Definition Panel, there are several elements which allow the user to control the editing of
zones (Figure 9.10, Figure 9.11):

• Button ’Insert New Zone’: This button is enabled if the Zone Definition Panel is disabled (i.e., no zone is currently edited).
Clicking this button disables the button itself and enables the Zone Definition Panel to specify the new zone.

• Button ’Delete Selected Zone’: This button is enabled if a table row in the Zone List is selected and the Zone Definition Panel is
disabled (i.e., no zone is currently edited). If this button is clicked, a confirmation dialog ’Deleting zone’ appears (Figure 9.9),
asking if this zone shall really be deleted from the user database. If ’Yes’ is clicked, the zone is removed from the Zone List.

• Button ’Edit Selected Zone’: This button is enabled if a table row in the Zone List is selected and the Zone Definition Panel is
disabled (i.e., no zone is currently edited). If this button is clicked, the ’Insert...’, ’Delete...’ and ’Edit...’ buttons are disabled,
and the Zone Definition Panel together with the remaining editor elements (see below) are enabled.

• Button ’Clear Zone Fields’: This button is enabled together with the Zone Definition Panel. If this button is clicked, the Zone
Definition Panel is cleared:

– The text fields in the Header subpanel are set blank.

– The zone type is set to ’Polygon’.

– The ’Circular’ subpanel is disabled, the values in its text fields are set to 0.0.

– The Polygon Point List is enables and contains a point (0.0, 0.0) as only entry.

• Button ’Save Zone Changes’: This button is enabled together with the Zone Definition Panel. If this button is clicked, a
validation of the entries in the Zone Definition Panel will be performed (see below). If the validation is successful, the zone
definition will be saved:
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– The Zone Definition Panel together with the editor elements below it will be disabled .

– The Zone List and the ’Insert New Zone’ button will be enabled.

– None of the zones in the Zone List is selected, the ’Delete Selected Zone’ button and the ’Edit Selected Zone’ button remain
disabled.

• Button ’Cancel Zone Changes’: This button is enabled together with the Zone Definition Panel. If this button is clicked, the
changes in the zone definition made after the last ’Insert New Zone’ or ’Delete Selected Zone’ are discarded. The panels and
their elements are set back to the state just before ’Insert New Zone’ or ’Delete Selected Zone’ was clicked.

Figure 9.9: Delete Zone Confirmation Dialog

Figure 9.10: Buttons ’Insert New Zone’, ’Delete Selected Zone’ and ’Edit Selected Zone’ (from left to right)

Figure 9.11: Buttons ’Clear Zone Fields’, ’Save Zone Changes’ and ’Cancel Zone Changes’ (from left to right)

9.2.5 Zone Validation

Before the definition for a new or an edited zone is saved, a validation of the input values is performed. The following rules are
checked:

• The Zone ID string must not be empty.

• The Zone ID must be unique with regard to the current user database and the system-defined stations.

• The Zone Description string must not be empty.

• The Center Longitude, Center Latitude and Diameter for a circular zone must not be empty.

• All Latitudes/Longitudes must have number format.

• All Longitudes must be in range [-180.0, 180.0].

• All Latitudes must be in range [-90.0, 90.0].

• The Diameter for a circular zone must have number format.

• The Diameter for a circular zone must be in range (0.0, 10000.0].

• A polygon zone must be formed by at least 3 points.

• A polygon zone must not be self-intersecting.
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Figure 9.12 to Figure 9.19 show several examples for the violation of the rules listed above. In each case, a Validation Dialog
appears after the button ’Save Zone Changes’ was clicked, and the relevant input fields are highlighted in red. (Note that in case
of an invalid point in the polygon list, a special ’Invalid Degree Value Dialog’ appears immediately when the user clicks into
another table cell to finish editing. This dialog allows either editing the invalid value, or going back to the last valid value in the
cell.)

Figure 9.12: Invalid zone definition: ID and Description missing, polygon has less than 3 points

Figure 9.13: Zone validation dialog
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Figure 9.14: Invalid circular zone definition: Center Longitude and Diameter out of range

Figure 9.15: Zone validation dialog

Figure 9.16: Polygon point invalid (out of range)

Figure 9.17: Invalid degree value dialog
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Figure 9.18: Invalid polygon (self-intersecting due to the latitude value in point 4)

Figure 9.19: Zone validation dialog

9.2.6 Button Panel

The buttons in the button panel (Figure 9.20.) give access to further functionalities of the Zone Database Editor.

• With the ’Help’ button, the online help for this component is opened.

• If the ’Close’ button is clicked, the Zone Database Editor is closed. Its status is kept and will reappear any time the dialog is
reopened.

Figure 9.20: Zone Database Editor Button Panel
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Chapter 10

Station Databases

10.1 What is a Station Database?

A station database is basically a xml-formatted file containing relevant information on stations which can be considered for an
Esov scenario. Station databases are divided into

• System-defined station database: In Esov, there is exactly one system-defined station database. The stations in this database
cannot be changed or deleted, nor can new stations be added. They do not contain specific AOS/LOS information, but only a
default elevation value which is, in combination with the station mask, used for the station perimeter computation. The system-
defined station database is also an xml-formatted file, but it is ’hidden’ in a jar archive which comes with the application. For
the Esov user, there is no need to access this file directly. The stations stored in this database become visible as ’system-defined’
stations in the ’Add stations’ toolwindow. These stations can be copied into a user-defined database (see Section 5.2.6). For
these station copies, the use can define own AOS/LOS parameters (see below).

• User-defined station database: In Esov, there is a default user-defined station database (’defaultstations.dbf’) in the Esov
application directory. If not existing, this file is created when Esov is started. Stations in this database can be edited or deleted
with the ESOV Station Database Editor, but, in opposite to Zones, it is not possible to define new stations with Esov. Also,
any other valid station database file can be set as user-defined station database. However, a station database file other than the
default file must have been created externally. It is not possible to create an ’empty’ user-defined station database from Esov.

10.2 Station Database Editor

The ESOV Station Database Editor can be activated by selecting ’Station Database...’ in the Edit menu of the main menu bar.
A modal dialog ’Station Database Editor’ appears (Figure 10.1). This window basically allows the user to define a database of
’user-defined’ stations, view the stations, and edit or delete stations.
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Figure 10.1: Station Database Editor

10.2.1 Database Selection Panel

In the Database Selection Panel (see Figure 10.2), the user can switch between the default user-defined station database (default
selection when the Station Database Editor is initially opened), and the definition of an ’Other User Database’.

• ’Other User Database’: If this button is selected, a non-editable text field and a ’Select User Database...’ button appear
on its right. When this button is clicked, an ’Open Database’ dialog appears. Its current directory is the Esov application
directory. The files available in this folder are database files with the extension ’.dbf’. (Note that also station database files
(see Chapter 10) which have the same extension are listed here. If the user accidentally selects a station database instead of a
station database, an error dialog appears that this file could not be read (Figure 10.3)).

Figure 10.2: Station Database Selection Panel
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Figure 10.3: Error dialog: Wrong database type

10.2.2 Station List Panel

In the Station List (Figure 10.4), the stations included in the selected user database are listed with their ID and Description. If a
station is selected in this table, it can be changed or deleted (see Section 10.2.4).

Figure 10.4: Station List Panel

10.2.3 Station Definition Panel

In the Station Definition Panel (Figure 10.7), the user can edit existing stations. This panel consists of the following input
elements:

• Text fields for

– Station ID (entry required)

– Station Description (entry required)

– AOS elevation (entry required, default value 0.0 deg.)

– LOS elevation (entry required, default value 0.0 deg.)

– Altitude (entry required, default value 0.0 km.)

– Longitude (entry required, default value 0.0 deg.)

– Latitude (entry required, default value 0.0 deg.)

• A radio button panel to select one of the following options for the computation of station perimeters:

– Consider AOS/LOS with mask (the default option)

– Consider AOS/LOS only

– Consider mask only
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Figure 10.5 and Figure 10.6 show an example for station perimeters computed for ’AOS/LOS with Mask’ and ’Mask only’,
respectively. If mask only is set, the AOS/LOS perimeters are neither considered for swath computation nor drawn in the map.

Figure 10.5: Station Perimeters: Example for setting ’AOS/LOS with Mask’

Figure 10.6: Station Perimeters: Example for setting ’Mask only’
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Figure 10.7: Station Definition Panel

10.2.4 Editor Elements

Underneath the Station List and the Station Definition Panel, there are several elements which allow the user to control the editing
of stations (Figure 10.9, Figure 10.10):

• Button ’Delete Selected Station’: This button is enabled if a table row in the Station List is selected and the Station Definition
Panel is disabled (i.e., no station is currently edited). If this button is clicked, a confirmation dialog ’Deleting station’ appears
(Figure 10.8), asking if this station shall really be deleted from the user database. If ’Yes’ is clicked, the station is removed
from the Station List.

• Button ’Edit Selected Station’: This button is enabled if a table row in the Station List is selected and the Station Definition
Panel is disabled (i.e., no station is currently edited). If this button is clicked, the ’Delete...’ and ’Edit...’ buttons are disabled,
and the Station Definition Panel together with the remaining editor elements (see below) are enabled.

• Button ’Clear Station Fields’: This button is enabled together with the Station Definition Panel. If this button is clicked, the
Station Definition Panel is cleared:

– The text fields ’Station ID’ and ’Station Description’ are set blank.

– The radio button AOS/LOS with mask’ is selected.

– The values of AOS and LOS elevation are set to 0.0.

• Button ’Save Station Changes’: This button is enabled together with the Station Definition Panel. If this button is clicked, a
validation of the entries in the Station Definition Panel will be performed (see below). If the validation is successful, the station
definition will be saved:

– The Station Definition Panel together with the editor elements below it will be disabled .

– The Station List will be enabled.

– None of the stations in the Station List is selected, the ’Delete Selected Station’ button and the ’Edit Selected Station’ button
remain disabled.
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• Button ’Cancel Station Changes’: This button is enabled together with the Station Definition Panel. If this button is clicked,
the changes in the station definition made after the last ’Insert New Station’ or ’Delete Selected Station’ are discarded. The
panels and their elements are set back to the state just before ’Insert New Station’ or ’Delete Selected Station’ was clicked.

Figure 10.8: Delete Station Confirmation Dialog

Figure 10.9: Buttons ’Delete Selected Station’ and ’Edit Selected Station’ (from left to right)

Figure 10.10: Buttons ’Clear Station Fields’, ’Save Station Changes’ and ’Cancel Station Changes’ (from left to right)

10.2.5 Station Validation

Before the definition for an edited station is saved, a validation of the input values is performed. The following rules are checked:

• The Station ID string must not be empty.

• The Station ID must be unique with regard to the current user database and the system-defined stations.

• The Station Description string must not be empty.

• The values ’AOS elevation’ and ’LOS elevation’ must not be empty.

• The values ’AOS elevation’ and ’LOS elevation’ must have number format.

• The values ’AOS elevation’ and ’LOS elevation’ must be in the range [0.0,90.0].

• The value of ’LOS elevation’ must not be greater than the value of ’AOS elevation’.

Figure 10.11 to Figure 10.16 show several examples for the violation of the rules listed above. In each case, a Validation Dialog
appears after the button ’Save Station Changes’ was clicked, and the relevant input fields are highlighted in red.

Figure 10.11: Invalid station definition: ID and Description missing
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Figure 10.12: Station validation dialog

Figure 10.13: Invalid AOS/LOS definitions: AOS > 90 deg., LOS empty

Figure 10.14: Station validation dialog

Figure 10.15: Invalid: LOS > AOS
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Figure 10.16: Station validation dialog

10.2.6 Button Panel

The buttons in the button panel (Figure 10.17.) give access to further functionalities of the Station Database Editor.

• With the ’Help’ button, the online help for this component is opened.

• If the ’Close’ button is clicked, the Station Database Editor is closed. Its status is kept and will reappear any time the dialog is
reopened.

Figure 10.17: Station Database Editor Button Panel
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Chapter 11

Data Export/Import

11.1 Export of Segments

11.1.1 SCF Export

To save computed segments in a swath control file (SCF)), there is an entry in the File menu: ’Export Segments...’ --> ’SCF...’.
An SCF file can be saved in XML format only. Therefore, if this menu entry is selected, another submenu with the only entry
’XML’ is opened. If the ’XML’ entry in this submenu is selected, a directory chooser dialog ’Save Swath Control Files to
Directory’ is opened (Figure 11.1). The selected directory is the Esov application directory. In this dialog, select a directory or
create a new one by clicking the upper right icon ’Create a new folder under the selected folder’. Then click ’Save’. For each
instrument of the current Scenario whose scope is not set to OFF, an SCF file will be written to the selected directory. The name
convention for the file is

• ’{instrument_name}.SCF’ (XML format)

If an SCF file already exists under this name, the user will be informed by a confirmation dialog (Figure 11.2). In case you want
to overwrite the existing SCF file, click ’OK’.
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Figure 11.1: Save SCF Dialog

Figure 11.2: Save SCF Confirmation Dialog

11.1.2 LLF Export

To save computed segments in a latitude/longitude file (LLF), there is an entry in the File menu: ’Export Segments...’ --> ’LLF...’.
If this menu entry is selected, another submenu with the entries ’XML’, ’CSV’ and ’ASCII’ is opened, providing the choice to
save in either XML, CSV or ASCII format. If one of the entries in this submenu entry is selected, a directory chooser dialog
’Save LLF Files to Directory’ is opened (Figure 11.3). The selected directory is the Esov application directory. In this dialog,
select a directory or create a new one by clicking the upper right icon ’Create a new folder under the selected folder’. Then click
’Save’. For each instrument of the current Scenario whose scope is not set to OFF, an LLF file will be written to the selected
directory. The name convention for the file is

• ’{instrument_name}.llf’ for XML format

• ’{instrument_name}_LLF.csv’ for CSV format

• ’{instrument_name}_LLF.txt’ for ASC format

If an LLF file already exists under this name, the user will be informed by a confirmation dialog (Figure 11.4). In case you want
to overwrite the existing LLF file, click ’OK’.
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Figure 11.3: Save LLF Dialog

Figure 11.4: Save LLF Confirmation Dialog

Note that the time step used in the ata export is set through the parameter "Time Step" in User Preferences, Section Section 12.3.

11.1.3 UTF Export

To save computed segments in a UTF file, there is an entry in the File menu: ’Export Segments...’ --> ’UTF...’. If this menu
entry is selected, another submenu with the entries ’XML’, ’CSV’ and ’ASCII’ is opened, providing the choice to save in either
XML, CSV or ASCII format. If one of the entries in this submenu entry is selected, a directory chooser dialog ’Save UTF Files
to Directory’ is opened (Figure 11.5). The selected directory is the Esov application directory. In this dialog, select a directory
or create a new one by clicking the upper right icon ’Create a new folder under the selected folder’. Then click ’Save’. For each
instrument of the current Scenario whose scope is not set to OFF, an UTF file will be written to the selected directory. The name
convention for the file is

• ’{instrument_name}.utf’ for XML format

• ’{instrument_name}_UTF.csv’ for CSV format

• ’{instrument_name}_UTF.txt’ for ASC format
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If an UTF file already exists under this name, the user will be informed by a confirmation dialog (Figure 11.6). In case you want
to overwrite the existing UTF file, click ’OK’.

Figure 11.5: Save UTF Dialog

Figure 11.6: Save UTF Confirmation Dialog

11.1.4 KML Export

To save computed segments in a KML file, there is an entry in the File menu: ’Export Segments...’ --> ’KML...’. A KML file can
be saved in XML format only. Therefore, if this menu entry is selected, another submenu with the only entry ’XML’ is opened.
If the ’XML’ entry in this submenu is selected, a directory chooser dialog ’Save KML to Directory’ is opened (Figure 11.7). The
selected directory is the Esov application directory. In this dialog, select a directory or create a new one by clicking the upper
right icon ’Create a new folder under the selected folder’. Then click ’Save’. For each instrument of the current Scenario whose
scope is not set to OFF, a KML file will be written to the selected directory. The name convention for the file is

• ’{instrument_name}.KML’ (XML format)

If a KML file already exists under this name, the user will be informed by a confirmation dialog In case you want to overwrite
the existing KML file, click ’OK’.
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Figure 11.7: Save KML Dialog

11.1.5 Importing CSV data to Excel

To import the generated CSV-Files to Excel, please use the following steps:

• Launch the Text Import Wizard (Excel/Data/Get External Data/Import Text file...) every time to be able to select the separation
character.

• Select ’semicolon’ as delimiter.

• Column style of the 2nd part of UTC time: Format cells as "Custom: hh:mm:ss.000".

11.2 Export of Map Images

11.2.1 PDF Export

To save the current map in a PDF file, there is an entry in the File menu: ’Export Image...’ --> ’PDF...’. If this menu entry is
selected, a file chooser dialog ’Export View to PDF File’ is opened (Figure 11.8). The current directory is the Esov application
directory. In this dialog, type a filename and click ’Save’. If this file does not already exist, the ’Save’ dialog disappears, and
the PDF is saved in a file with extension ’.PDF’. If this PDF file already exists, you will be informed by a confirmation dialog
(Figure 11.9). In case you want to overwrite the existing PDF file, click ’OK’.
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Figure 11.8: Save PDF File Dialog

Figure 11.9: Save PDF File Confirmation Dialog

11.2.2 GIF Export

To save the current map in a GIF file, there is an entry in the File menu: ’Export Image...’ --> ’GIF...’. If this menu entry is
selected, a file chooser dialog ’Export View to GIF File’ is opened (Figure 11.10). The current directory is the Esov application
directory. In this dialog, type a filename and click ’Save’. If this file does not already exist, the ’Save’ dialog disappears, and
the GIF is saved in a file with extension ’.GIF’. If this GIF file already exists, you will be informed by a confirmation dialog
(Figure 11.11). In case you want to overwrite the existing GIF file, click ’OK’.
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Figure 11.10: Save GIF File Dialog

Figure 11.11: Save GIF File Confirmation Dialog

11.2.3 PNG Export

To save the current map in a PNG file, there is an entry in the File menu: ’Export Image...’ --> ’PNG...’. If this menu entry is
selected, a file chooser dialog ’Export View to PNG File’ is opened (Figure 11.12). The current directory is the Esov application
directory. In this dialog, type a filename and click ’Save’. If this file does not already exist, the ’Save’ dialog disappears, and
the PNG is saved in a file with extension ’.png’. If this PNG file already exists, you will be informed by a confirmation dialog
(Figure 11.13). In case you want to overwrite the existing PNG file, click ’OK’.
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Figure 11.12: Save PNG File Dialog

Figure 11.13: Save PNG File Confirmation Dialog

11.3 Import of data files

11.3.1 Shapefiles Import

To import shapefiles into the user defined shapefiles folder, there is an entry in the File menu: ’Import ...’ --> ’Shapefile...’. If this
option is is selected, a file chooser dialog ’Import shapefile’ is opened. (Figure 11.14). The selected shapefile (.shp extension)
shall be copied to the user shapes directory. This directory is located in the Esov application directory (’user_shape_files’).
ESOV copies shapefiles that consist at least of:

• *.shp: contains the geometry data

• *.dbf: contains the attribute data

• *.shx: contains the connection between attributes and geometries

• *.prj: contains the projection information of the data
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Figure 11.14: Import Shapefile chooser Dialog

11.3.2 Points of Interest Files Import

To import files specifiying points of interest, there is an entry in the File menu: ’Import ...’ --> ’Point of Interest...’. If this option
is is selected, a file chooser dialog ’Import shapefile’ is opened. (Figure 11.15). The selected file (.csv extension) shall be a
Comma separated values format where each line shall have three entries:

• longitude: the longitude of the point (degrees)

• latitude: the latitude of the point (degrees)

• label: a text to identify the point

Figure 11.15: Import Points of Interest chooser Dialog
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11.3.3 Sub Satellite Points File Import

To import files specifiying sub-satellite points to display, there is an entry in the File menu: ’Import ...’ --> ’Sub-Satellite Point...’.
If this option is is selected, a file chooser dialog ’Load SSPs’ is opened. (Figure 11.16). The selected file (.csv extension) shall
be a list of UTC times in the format YYYY-MM-DDTHH:MM:SS one in each line.

To visualise the imported file follow the next two steps:

• Make sure that the orbit / time interval in the orbit tool window contains the UTC times in the Sub-Satellite Points File

• Tick the SSP checkbox in the the ’SSP’ tool window

Figure 11.16: Sub-Satellite Points File chooser Dialog
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Chapter 12

User Preferences

The User Preferences Dialog (Figure 12.1) is the GUI component in which user preferences can be set.

Figure 12.1: User Preferences Dialog

12.1 Toolbar Elements

In the User Preferences Dialog Toolbar the user can find as only element:

• Help Button: Invokes the Online Help for this toolwindow.

Note that no ’Apply’ icon is provided here since relevant changes related to this toolwindow are applied if the ’OK’ button is
clicked.

12.2 Scenario File Settings

The Scenario File Settings panel has as only element:

• Checkbox: ’Store spatial segment coordinates in scenario file’

If this checkbox is selected, spatial segment coordinates will be stored additionally to the time segments in a scenario file (see
Section 5.4). There will be as many spatial coordinates stored as ’Points per orbit’ are set in the Orbit Settings panel.
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12.3 Swath Export Settings

The Swath Export Settings panel has as elements:

• Checkbox: ’Calculate intermediate points in exported files’. If this checkbox is selected, intermediate swath coordinates will
be computed according to a user-defined time step (set in the text field below). These intermediate coordinates are written only
into an ’enhanced’ LLF file and do not appear in the current scenario.

• Text field: ’Time Step (seconds)’ Set the user-defined time step here.

12.4 Zoom Settings

The Zoom Settings panel has one element:

• Checkbox: ’Display crosshair cursor’. If this checkbox is selected, zooming will utilize a crosshair cursor (Figure 12.2) giving
visual feedback of what will be contained in a map when a zoom operation has been completed. As zoom in the azimuthal and
gnomonic projection follows latitude/longitude boundaries, this can help determining where to start zooming.

Figure 12.2: Zoom with crosshair cursor: purple lines are the crosshair cursor
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Chapter 13

An Example for a ’Common Use Case’

The following section shall illustrate the use of Esov for a ’common use case’ which in this way is needed very often.

Suppose you want to set up a scenario as defined in the following steps. For each step, the distinct user action to be performed
will be given. The actions are described in brief here, they can be looked up in detail in the relevant sections of this manual if
needed.

• Swaths of the instruments ’MERIS’ and ’ATSR_N’ onboard the ENVISAT spacecraft shall be investigated.

--> Start Esov. Select ’New scenario’. Select ’ENVISAT’.

• Regions of interest are the zone ’Africa’ and the area of station ’Gatineau’.

--> In the ’Add Zones’ dialog , add zone ’Africa’ to the scenario. In the ’Add Stations’ dialog , add station ’Gatineau’ to the
scenario.

• For ATSR_N, you are only interested in swaths relevant for ’Gatineau’.

--> In the Instruments Toolwindow, set the scope of instrument ’ATSR_N’ to ’STATION’.

• For MERIS, you want to look at swaths over Africa.

--> In the Instruments Toolwindow, set the scope of instrument ’MERIS’ to ’ZONE’.

• You want to consider just the first 10 orbits of the first orbit change, starting on 2000-01-01. Then you want to compute the
swaths.

--> In the Orbit Settings Toolwindow, set the number of orbits to 10. Click ’Apply’.

• You would like a doubled resolution of the latitude/longutide grid lines.

--> In the Layer Manager, select the node ’Grid’. With the Grid Style Editor in the Style Toolwindow, set the resolution to 15
deg.

• You would like the zone polygon to be shown as dashed line.

--> In the Layer Manager, select the node ’Zones’. With the Zone Editor in the Style Toolwindow, set the style to ’Dashed’.

• You would like to see the station label. You prefer triangular station symbols.

--> In the Layer Manager, select the node ’Stations’. With the Station Editor in the Style Toolwindow, set ’Style’ to ’Triangular’
and ’Label’ to ’Yes’.

• You would like to have a filled station perimeter with an opacity of 20 percent.

--> In the Layer Manager, select the node ’Station Perimeters’. With the Station Perimeter Editor in the Style Toolwindow, set
’Opacity’ to 20 percent and ’Filled’ to ’Yes’.

• You want to know which orbit numbers belong to the computed segments.

--> In the Orbit Settings Toolwindow, set checkbox ’Show Orbit Numbers’. Click ’Apply’.
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• You do not want to see the full ENVISAT orbit in the map.

--> In the Layer Manager, set the visibility of ORBIT to OFF.

• You want to have a closer look to the regions of interest.

--> With the Zoom Tool, perform a ’Drag’ zoom which just includes all the swaths displayed.

• You are especially interested in the ATSR_N swath within orbit ’10’, and the MERIS swaths within orbits ’1’ and ’7’. There-
fore, you want to give them individual styles:

– ATSR_N: Opacity 60 percent, Color ’Cyan’ (00FFFF), and the swath area shown as ’Solid’.

– MERIS: Opacity 80 percent, Color ’Magenta’ (FF00FF), and the swath area shown as ’Solid’.

--> In the Instruments Tree of the Layer Manager, select ’ATSR_N’. In the Segments Toolwindow, select the swath with start
orbit ’10’. With the Swath Style Editor in the Style Toolwindow, set ’Opacity’ to 60 percent, Color to ’00FFFF’ and ’Style’ to
’Solid’. The do the equivalent steps for MERIS.

• For a better orientation, you want to see the background image.

--> In the Geographical Layers Tree of the Layer Manager, set the visibility of ’Background’ to ’ON’.

Now your application frame and your map should look about like in Figure 13.1. This is a result you may want to show around
and to be able to continue work with at a later time. Therefore, you want to save your data:

• You want to print this nice map.

--> In the ’File’ menu, select ’Print...’ and do the printing.

• You want to save the map as GIF file.

--> In the ’File’ menu, select ’Export Image...’ --> ’GIF...’ and save the file at a desired location.

• You want to save the swath data in an SCF file.

--> In the ’File’ menu, select ’Export Segments...’ --> ’SCF...’ and save the file at a desired location.

• You want to save the whole scenario.

--> In the ’File’ menu, select ’Save As...’ and save the scenario at a desired location.
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Figure 13.1: ’Common Use Case’ scenario. See text for details.
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Chapter 14

Application Layout

14.1 Toolwindow Arrangement

Esov offers a highly flexible layout arrangement (i.e., positioning and appearance of toolwindows), which is provided by the
JIDE Docking Framework. In general, this allows the user to perform operations like

• Open and close distinct toolwindows

• Show and hide distinct toolwindows

• Dock and undock (’float’) toolwindows

These operations with toolwindows are based on different modes a window can have. This is explained in more detail in the
following subsections.

14.1.1 Toolwindow Modes

A toolwindow can have one of the following modes:

• ’Autohide’

• ’Docked’

• ’Floated’

• ’Closed’

14.1.1.1 Autohide Mode

In ’Autohide’ mode, the toolwindow is hidden in general (shown as a tab on the main frame edge only), but shown if the mouse
is moved onto the distinct tab. It will stay visible as long as the mouse cursor remains on the tab or is moved into the window
itself.

Figure 14.1 shows the toolwindows ’Style’ and ’LayerManager’ in autohide mode on the left edge of the main frame. In
Figure 14.2, the Layer Manager is shown in this mode after the mouse was moved onto the distinct tab.
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Figure 14.1: Toolwindows in Autohide mode on left main frame edge.

Figure 14.2: Layer Manager Toolwindow shown in Autohide mode.

The title bar of a toolwindow which is displayed in autohide mode contains of three buttons (Figure 14.3):

• ’Hide active auto-hide window’ (left): If clicked, the toolwindow will be hidden.

• ’Toggle auto-hide’ (middle): If clicked, the toolwindow will be set into ’docked’ mode.

• ’Close’ (right): If clicked, the toolwindow will be set into ’closed’ mode and closed.

Figure 14.3: Title bar buttons of a toolwindow shown in autohide mode.

14.1.1.2 Docked Mode

In ’Docked’ mode, the toolwindow is connected with a distinct edge of the main frame. It is always visible as long as the mode
is not changed.

In Figure 14.4, the Layer Manager is shown in docked mode on the left edge of the main frame.
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Figure 14.4: Layer Manager Toolwindow shown in docked mode.

The title bar of a toolwindow which is displayed in docked mode contains of three buttons (Figure 14.5):

• ’Toggle floating’ (left): If clicked, the toolwindow will be set into ’floating’ mode.

• ’Toggle auto-hide’ (middle): If clicked, the toolwindow will be set into ’auto-hide’ mode.

• ’Close’ (right): If clicked, the toolwindow will be set into ’closed’ mode and closed.

Figure 14.5: Title bar buttons of a toolwindow shown in docked mode.

14.1.1.3 Floating Mode

In ’Floating’ mode, the toolwindow is ’free’ and not connected to the main frame. A floated toolwindow can be docked to the
main frame by clicking its upper edge and moving it (with mouse key kept pressed) to one of the edges of the main frame. To
avoid accidental docking which is not desired, hold the ’Ctrl’ key pressed while moving the window. The docking mechanism is
then suppressed. The toolwindow is always visible as long as the mode is not changed.

In Figure 14.6, the Layer Manager is shown in floating mode overlaying the main frame.

Figure 14.6: Layer Manager Toolwindow shown in floating mode.

The title bar of a toolwindow which is displayed in floating mode contains of three buttons (Figure 14.7):
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• ’Toggle floating’ (left): If clicked, the toolwindow will be set into ’docked’ mode.

• ’Close’ (right): If clicked, the toolwindow will be set into ’closed’ mode and closed.

Figure 14.7: Title bar buttons of a toolwindow shown in floating mode.

14.1.1.4 Closed Mode

In ’Closed’ mode, the toolwindow is not visible at all. It can be reopened by selecting the corresponding entry in the ’Windows’
menu in the main menu bar or typing the related shortcut letter. The mode of a reopened window will be the same as it was when
being closed.

14.2 Loading and saving Layouts

The overall state of the toolwindows is referred as ’Layout’. Distinct layouts can be saved and reloeaded. Also, a default layout
is provided which comes with a new Esov installation and can be reset any time. The corresponding layout operations can be
invoked from the ’Windows’ menu in the main menu bar.

14.2.1 Default Layout

When the installation has been installed and started the first time, the layout after creating a new (default) scenario looks as
in Figure 14.8. The ’Layer Manager’ and the ’Instruments’ toolwindows are shown in docked mode on the left edge of the
main frame, all other toolwindows are located in ’Autohide’ mode on the right edge of the main frame (see explanation in
Section 14.1.1).

At any time, the application can be reset to this default layout by clicking ’Reset Layout’ in the Windows menu.
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Figure 14.8: Esov with default layout

14.2.2 Saving a Layout

To save a layout which has been defined by arranging the toolwindows as desired, click ’Save Layout’ in the Windows menu. A
file save dialog ’Save a Layout’ appears (Figure 14.9), showing files with extension ’.layout’. Select the layout you want to save,
and click ’Save’. If this file does not already exist, the ’Save’ dialog disappears, and the layout is saved in a JIDE layout file with
extension ’.layout’. If this layout file already exists, you will be informed by a confirmation dialog (Figure 14.10). In case you
want to overwrite the existing layout file, click ’OK’.
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Figure 14.9: Save layout dialog

Figure 14.10: Save layout confirmation dialog

14.2.3 Loading a Layout

To open an existing layout, click ’Load Layout’ in the File menu. A file choose dialog ’Open a Layout’ appears (Figure 14.11),
showing files with extension ’.layout’. Select the layout you want to open, and click ’Open’. The dialog ’Open a Layout’ is
closed, and the application layout is updated accordingly.
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Figure 14.11: Open scenario dialog

14.3 Look and Feel

Esov also offers the opportunity to choose between different ’Look and Feels’ for the application. To set a different Look and
Feel, select the menu item ’Look and Feel’ in the Windows menu (Figure 14.12). Note that the ’Aqua’ Look and Feel is only
available for Mac OS X.
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Figure 14.12: Look and Feel Submenu
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Chapter 15

Help System

15.1 Online Help

Esov gives the user the option to display online help through a separate window (Figure 15.1). The online help is triggered by
the several help buttons in the toolwindows and from the ’Help...’ entry in the ’Help’ menu.

Help in Esov is ’window sensitive’. This means that when pressing the help button on a toolwindow, the help window opens
with the distinct section on this toolwindow shown. This ’window sensitive’ mechanism is also invoked if the ’F1’ key is pressed
while the mouse cursor is located in the toolwindow area. Furthermore, links are added to the help documents to easily navigate
through all the help subjects.

Figure 15.1: Esov Online Help
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15.2 ’About’ Dialog

If the ’About...’ entry in the ’Help’ menu is selected, an ’About’ dialog appears (Figure 15.2) which shows some general
information about Esov. This includes the version number and relevant links.

Figure 15.2: ’About’ Dialog
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Chapter 16

Stopping Esov

Esov can be exited (stopped) in two ways:

• Click the ’Close’ cross in the upper right of the main frame.

• Select the ’Exit’ menu item in the File menu of the main menu bar.

If no scenario has been selected (empty main frame), the application will exit immediately.

If a scenario has been selected, a confirmation dialog (Figure 16.1) will appear. This dialog also contains a drop-down list in
which you have to select if you want to be asked to confirm exit in future, or not to be asked again. After you made your selection,
click ’OK’. Now you are asked to save the current scenario (as described in Section 5.4). After saving (or cancellation of saving),
the application will exit.

Figure 16.1: Exit confirmation dialog

If you selected ’Do not ask again’ in the confirmation dialog, you will not be asked for confirmation in future. If you want to
reactivate the confirmation mechanism in this case, go to the Esov application directory (see Section 2.5.2) on the file system and
remove the file ’notAskForExitConfirm’.
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Chapter 17

Updating Esov

17.1 Update Options

The Esov application can be updated to the most recent available version in two ways:

• Update by a version check at startup.

• Update by a version check from an entry in the Help menu of the main menu bar.

17.1.1 Updating when starting Esov

If the application is started, a confirmation dialog ’Check for new versions of Esov...’ (Figure 17.1) will appear. This dialog also
contains a drop-down list in which you have to select if you want to be asked for this version check in future, or not to be asked
again.

Figure 17.1: Esov version check dialog

If you selected ’Do not ask again’ in the version check dialog, you will not be asked for a version check in future. If you want
to reactivate the version check mechanism in this case, go to the Esov application directory (see Section 2.5.2) on the file system
and remove the file ’notAskForCheckForUpdates’.

After clicking ’OK’ in the version check dialog, the version check is invoked, and an information dialog with a progress bar
appears (Figure 17.2).
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Figure 17.2: Esov updater dialog

If there is a new version available, a confirmation dialog is shown which informs the user about the new version number and asks
if this version shall be downloaded. (Figure 17.3).

Figure 17.3: Esov update: new version available

If the user decides to download the new version, an information dialog is shown which informs the user about the status of the
current download (Figure 17.4).
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Figure 17.4: Esov update: downloading new version

If the download is finished, another confirmation dialog is shown which asks the user if the new version shall be installed right
now. (Figure 17.5).

Figure 17.5: Esov update: download finished

If there is no new version available, the version check at startup will result in an information dialog which informs the user that
he is already using the latest version. (Figure 17.6).
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Figure 17.6: Esov update: latest version is used

17.1.2 Updating from Help menu

The update mechanism can also be invoked any time from the ’Help’ menu (see Section 4.2.2.5). If the entry ’Check for new
Esov versions...’ is selected, the version check is invoked in the same way as described in Section 17.1.1

17.1.3 Updating from Help menu

The mission files update can be invoked any time from the ’Help’ menu (see Section 4.2.2.5). If the entry ’Check for new mission
files...’ is selected, a dialog will appear with the list of mission files to be update (see figure Figure 17.7).

Figure 17.7: List of missions to be updated.

Clicking in the download button will cause the download/update of the mission listed. If there is no mission to be update, the
dialog of figure Figure 17.8 will appear.

Figure 17.8: List of missions to be updated.
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Chapter 18

Hints and Tips

18.1 General EsovNG Tips

One of the main principle the user has to consider when using EsovNG is that

• Esov performs a complete swath recomputation every time the current scenario was changed and the changes are applied
(automatically or manually).

• Esov only performs a map update (refresh) if graphical parameters are changed, toolwindows change their state from docked
to autohide, or the main window is resized.

Therefore, some basic tips to work effectively would be:

• Arrange your layout and Resize the main window to the size you want before doing anything else, i.e. adding lots of layers. If
a priori known, zoom also into the region of interest before you compute swaths. The more layers and the larger the region to
draw, the more time is needed for a map refresh.

• On the other hand, add the background image (if wanted) if everything is done. Map refreshes take more time if the background
image layer is visible.

• To save computation steps, do all your orbit settings at once, then apply.

• To save refresh steps, do all your map settings at once, then apply.
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Chapter 19

Appendix

19.1 Adding a new spacecraft to Esov

The user can easily add a new spacecraft to Esov. The procedure is as follows:

• On the file system, go to the subfolder ’user_instrument_swath’ in the Esov application folder (see section Section 2.5.2 ).
Here, make a copy of the folder "SAT_EXAMPLE" and rename it with the name of the new spacecraft (in capital letters, e.g.
NEWSAT).

• Go to the new subfolder. Rename the IDF file to the name of the new spacecraft (e.g., NEWSAT.idf).

• Edit this IDF file. Change the filename and the spacecraft name accordingly (e.g. to NEWSAT). Also, change the Eecfi_Id
to the ID which has been foreseen for this spacecraft, or to ’200’ if no ID has been specified yet. The File_Extension is used
to associate the Swath Definition Files (SDF) to a spacecraft. The orbit parameters in the Default_Settings section need to
be updated according to the new mission.The minimum and maximum number of orbits per day ( fields Min_Orbits_Day and
Max_Orbit_Day) can be translated into minimum and maximum altitude range for the mission, so they need to be updated
consistently with the the repeat cycle and cycle length values.

• In the new IDF file, set all default settings in the ’Spacecraft’ block. Also, add all instruments of the new spacecraft to the
’List_of_Instruments’ or modify the example sensors (see example in Section 19.3.2 )

• Add/modify the SDF files for all instruments of the new spacecraft to the new subfolder. The spacecraft name and instrument
names need to be set consistently in all the -files. SDF file format is described in EO CFI SW Data Handling User Manual
[CFI].

• Restart Esov and select ’File --> New’ in the file menu. The new spacecraft will appear in the drop-down list of spacecrafts
and can be selected for a new scenario.

19.2 Command Line Interface

Esov makes available an export functionality through its Command Line Interface. The input to this capability shall be an Esov
scenario file (XML). The output shall be any of the Export Segments formats.

Usage: <esovng_executable> -cli <scenario_file> <format> <output>

Where:

• esovng_executable -> the path to the EsovNG executable in the file system

• scenario_file -> the full path to the scenario file
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• format -> one of: SCF_XML, LLF_XML, LLF_CSV, LLF_ASCII, UTF_XML, UTF_CSV, UTF_ASCII, KML_XML, IMG_PDF,
IMG_PS, IMG_GIF, IMG_PNG

• output -> the path to the folder storing the exported files (if format other than IMG_PDF, IMG_PS, IMG_GIF, IMG_PNG) or
the filename including path of the exported image file (if format one of IMG_PDF, IMG_PS, IMG_GIF, IMG_PNG)

The application executable path depends on the Operating System

• Windows: <installation_folder>/esovng.exe (e.g. ’C:\Program Files\Esov\esovng.exe’)

• Mac OS X: <installation_folder>/esovng.app/Contents/MacOS/JavaApplicationStub (e.g. ’/Applications/EsovNG/esovng.app/
Contents/MacOS/JavaApplicationStub’)

• Linux: <installation_folder>/esovng (e.g. ’/home/user/esovng/esovng’)

where <installation_folder> is the folder selected at installation time.

19.3 Examples of standard files used by Esov

19.3.1 Scenario File

The following listing shows an example for a Scenario File:

<?xml version = "1.0" encoding = "UTF-8"?>
<Earth_Explorer_File>
<Data_Block>

<Esov_Scenario>
<File_Name>C:\example_scenario.xml</File_Name>
<List_of_Maps count="1">
<Map>

<Name>Map 1</Name>
<Show_Title>true</Show_Title>
<Projection>RECTANGULAR</Projection>
<North_Latitude unit="deg">90.0</North_Latitude>
<South_Latitude unit="deg">-90.0</South_Latitude>
<West_Longitude unit="deg">-180.0</West_Longitude>
<East_Longitude unit="deg">180.0</East_Longitude>
<Center_Longitude unit="deg">0.0</Center_Longitude>
<Center_Latitude unit="deg">90.0</Center_Latitude>
<View_Angle unit="deg">45.0</View_Angle>
<Rotation_Angle unit="deg">0.0</Rotation_Angle>

</Map>
</List_of_Maps>
<List_of_Spacecraft_Settings count="1">
<Spacecraft_Settings>

<Orbit_Settings>
<Spacecraft_Id>ADM</Spacecraft_Id>
<Use_Osf>false</Use_Osf>
<Osf></Osf>
<List_of_Osf_Records count="1">
<Osf_Record>
<Abs_Orbit>1</Abs_Orbit>
<Rel_Orbit>0</Rel_Orbit>
<Cycle_Num>0</Cycle_Num>
<Phase_Num>0</Phase_Num>
<Repeat_Cycle>7</Repeat_Cycle>
<Cycle_Length>109</Cycle_Length>
<Mlst>18.0</Mlst>
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<Mlst_Drift>0.0</Mlst_Drift>
<Anx_Time>0.0</Anx_Time>
<Anx_Longitude unit="deg">0.0</Anx_Longitude>
<Date>2000-01-01T00:00:00</Date>
<Drift_Mode>0</Drift_Mode>
<Inclination>0.0</Inclination>

</Osf_Record>
</List_of_Osf_Records>
<Selected_Osf_Record>0</Selected_Osf_Record>
<Start_Orbit>1</Start_Orbit>
<Num_Orbits>1</Num_Orbits>
<Num_Points_per_Orbit>100</Num_Points_per_Orbit>
<Show_Orbit_Numbers>false</Show_Orbit_Numbers>
<Visibility>FULL</Visibility>

</Orbit_Settings>
<Instrument_Settings>
<List_of_Instruments count="2">
<Instrument>
<Sensor_Name>ALADIN</Sensor_Name>
<Scope>OFF</Scope>
<List_of_Segments count="0"/>

</Instrument>
<Instrument>
<Sensor_Name>ORBIT</Sensor_Name>
<Scope>ON</Scope>
<List_of_Segments count="1">

<Segment>
<Name>#0</Name>
<Instruments_Layer_Style>
<Opacity>100</Opacity>
<Line_Color>FFFFFF</Line_Color>
<Swath_Style>SOLID</Swath_Style>
<Fill_Color>FFFFFF</Fill_Color>
<Fill_Style>HOLLOW</Fill_Style>

</Instruments_Layer_Style>
<List_of_Orbit_Timestamps count="2">
<Orbit_Timestamp>
<Orbit>1</Orbit>
<Seconds>0.0</Seconds>

</Orbit_Timestamp>
<Orbit_Timestamp>
<Orbit>1</Orbit>
<Seconds>54.93686983377237</Seconds>

</Orbit_Timestamp>
</List_of_Orbit_Timestamps>

</Segment>
</List_of_Segments>

</Instrument>
</List_of_Instruments>

</Instrument_Settings>
<Zone_Settings>
<Zones_Layer_Style>
<Opacity>1.0</Opacity>
<Zone_Color>FF0000</Zone_Color>
<Zone_Style>SOLID</Zone_Style>

</Zones_Layer_Style>
<Zones_Filled>false</Zones_Filled>
<List_of_Zones count="0"/>

</Zone_Settings>
<Station_Settings>
<Stations_Layer_Style>
<Opacity>1.0</Opacity>
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<Station_Color>FF00FF</Station_Color>
<Station_Style>CIRCULAR</Station_Style>
<Station_Symbol_Size>7</Station_Symbol_Size>

</Stations_Layer_Style>
<Stations_Id_Displayed>false</Stations_Id_Displayed>
<Station_Perimeters_Layer_Style>
<Opacity>1.0</Opacity>
<Perimeter_Color>FFC800</Perimeter_Color>
<Perimeter_Style>SOLID</Perimeter_Style>

</Station_Perimeters_Layer_Style>
<List_of_Stations count="0"/>

</Station_Settings>
</Spacecraft_Settings>

</List_of_Spacecraft_Settings>
</Esov_Scenario>

</Data_Block>
</Earth_Explorer_File>

19.3.2 Satellite Identification File

The following listing shows an example for a Satellite Identification File:

<?xml version = "1.0" encoding = "UTF-8"?>
<Earth_Explorer_File
xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance"

xsi:schemaLocation="http://eop-cfi.esa.int/CFI
http://eop-cfi.esa.int/CFI/EE_CFI_SCHEMAS/
EO_OPER_MPL_ORBSCT_0100.XSD"
xmlns="http://eop-cfi.esa.int/CFI" schemaVersion="1.0">
<Earth_Explorer_Header>

<Fixed_Header>
<File_Name>ADM.idf</File_Name>
<File_Description>Satellite Identification File

</File_Description>
<Notes></Notes>
<Mission></Mission>
<File_Class></File_Class>
<File_Type></File_Type>
<Validity_Period>
<Validity_Start></Validity_Start>
<Validity_Stop></Validity_Stop>

</Validity_Period>
<File_Version>1.0</File_Version>
<Source>
<System></System>
<Creator></Creator>
<Creator_Version></Creator_Version>
<Creation_Date></Creation_Date>

</Source>
</Fixed_Header>
<Variable_Header></Variable_Header>

</Earth_Explorer_Header>
<Data_Block type="xml">

<Idf>
<Spacecraft>
<Name>ADM</Name>
<Eecfi_Id>51</Eecfi_Id>
<File_Extension>.ADM</File_Extension>
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<Min_Orbits_Day>15.47</Min_Orbits_Day>
<Max_Orbits_Day>15.67</Max_Orbits_Day>
<Uses_DRS>false</Uses_DRS>
<Default_Settings>

<Repeat_Cycle unit="day">7</Repeat_Cycle>
<Cycle_Length unit="orbit">109</Cycle_Length>
<MLST unit="h">18.0</MLST>
<MLST_Drift unit="s/day">0.0</MLST_Drift>
<ANX_Longitude unit="deg">0.0</ANX_Longitude>

<Date>2000-01-01T00:00:00</Date>
<Absolute_Reference_Orbit>1</Absolute_Reference_Orbit>

</Default_Settings>
<List_of_Instruments count="2">

<Instrument>
<Name>ORBIT</Name>
<Display_Name>Orbit</Display_Name>
<Swath_Type>POINT</Swath_Type>
<Appearance>
<Colour>FFFFFF</Colour>
<Draw>SOLID</Draw>
<Fill>HOLLOW</Fill>
<Opacity>100</Opacity>

</Appearance>
</Instrument>
<Instrument>
<Name>ALADIN</Name>
<Display_Name>Aladin swath</Display_Name>
<Swath_Type>LINE</Swath_Type>
<Appearance>
<Colour>FF80FF</Colour>
<Draw>SOLID</Draw>
<Fill>HOLLOW</Fill>
<Opacity>100</Opacity>

</Appearance>
</Instrument>

</List_of_Instruments>
</Spacecraft>

</Idf>
</Data_Block>

</Earth_Explorer_File>

19.3.3 Swath Control File

The following listing shows an example for a Swath Control File:

<?xml version = "1.0" encoding = "UTF-8"?>
<Earth_Explorer_File xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance" xsi: ←↩

schemaLocation="http://eop-cfi.esa.int/esov http://eop-cfi.esa.int/esov/ ←↩
ESOVNG_SCHEMAS/EO_ESOVNG_SCF_0100.XSD" xmlns="http://eop-cfi.esa.int/esov" ←↩
schemaVersion="1.0">

<Earth_Explorer_Header>
<Fixed_Header>
<File_Name>ALADIN.scf</File_Name>
<File_Description>Swath Control File</File_Description>
<Notes>...</Notes>
<Mission>AEOLUS</Mission>
<File_Class>TEST</File_Class>
<File_Type>ESOVNG_SCF</File_Type>
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<Validity_Period>
<Validity_Start>UTC=2000-01-01T18:00:02</Validity_Start>
<Validity_Stop>UTC=2000-01-01T21:04:59</Validity_Stop>

</Validity_Period>
<File_Version>0001</File_Version>
<Source>

<System>Esov</System>
<Creator>Esov</Creator>
<Creator_Version>2.2</Creator_Version>
<Creation_Date>UTC=2015-04-17T18:57:49</Creation_Date>

</Source>
</Fixed_Header>
<Variable_Header>
<Init_Def_Data>

<Orbit>
<Absolute_Orbit>1</Absolute_Orbit>

</Orbit>
<Cycle>
<Repeat_Cycle unit="day">7</Repeat_Cycle>
<Cycle_Length unit="orbit">109</Cycle_Length>
<ANX_Longitude unit="deg">0.0</ANX_Longitude>
<MLST unit="h">18.0</MLST>
<MLST_Drift unit="s/day">0.0</MLST_Drift>
<Date>2000-01-01T18:00:02</Date>

</Cycle>
</Init_Def_Data>

</Variable_Header>
</Earth_Explorer_Header>
<Data_Block type="xml">
<Scf>
<Instrument>ALADIN</Instrument>
<List_of_Segments count="1">

<Segment>
<Start>
<Absolute_Orbit>1</Absolute_Orbit>
<Time_From_ANX unit="s">0.0</Time_From_ANX>
<UTC>2000-01-01T18:00:02.123636</UTC>

</Start>
<Stop>
<Absolute_Orbit>2</Absolute_Orbit>
<Time_From_ANX unit="s">5548.623853211009</Time_From_ANX>
<UTC>2000-01-01T21:04:59.371342</UTC>

</Stop>
<Zone>ZEUR____</Zone>
<Station></Station>
<Geo></Geo>

<Appearance>
<Colour>FF80FF</Colour>
<Draw>SOLID</Draw>
<Fill>SOLID</Fill>
<Opacity>50.0</Opacity>

</Appearance>
</Segment>

</List_of_Segments>
</Scf>

</Data_Block>
</Earth_Explorer_File>
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19.3.4 Swath Definition File

SDF file format is described in EO CFI SW Data Handling User Manual [CFI] ( Section 1.4 )

19.3.5 Orbit Scenario File

OSF file format is described in EO CFI SW Data Handling User Manual [CFI] ( Section 1.4 )

19.3.6 Predicted Orbit File (POF)

POF file format is described in EO CFI SW Data Handling User Manual [CFI] ( Section 1.4 )

19.3.7 Restituted Orbit File (ROF)

ROF file format is described in EO CFI SW Data Handling User Manual [CFI] ( Section 1.4 )

19.3.8 Zone Database File

Zone database file format is described in EO CFI SW Data Handling User Manual [CFI] ( Section 1.4 )

19.3.9 Station Database File

Station DB file format is described in EO CFI SW Data Handling User Manual [CFI] ( Section 1.4 )

19.3.10 Zone List File

The following listing shows an example for a Zone List File:

<?xml version = "1.0" encoding = "UTF-8"?>
<Earth_Explorer_File>

<Earth_Explorer_Header>
<Fixed_Header>
<File_Name>C:\myzonelist.zlf</File_Name>
<File_Description>Zones List File</File_Description>
<Notes></Notes>
<Mission></Mission>
<File_Class></File_Class>
<File_Type></File_Type>
<Validity_Period>

<Validity_Start></Validity_Start>
<Validity_Stop></Validity_Stop>

</Validity_Period>
<File_Version>1.0</File_Version>
<Source>

<System></System>
<Creator></Creator>
<Creator_Version></Creator_Version>
<Creation_Date></Creation_Date>

</Source>
</Fixed_Header>
<Variable_Header></Variable_Header>

</Earth_Explorer_Header>
<Appearance>
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<Opacity>100</Opacity>
<Zone_Color>FF0000</Zone_Color>
<Zone_Style>SOLID</Zone_Style>

</Appearance>
<List_of_Zones count="2">
<Zone>
<Name>ZAFR____</Name>

</Zone>
<Zone>
<Name>ZNAM____</Name>

</Zone>
</List_of_Zones>

</Earth_Explorer_File>

19.3.11 Station List File

The following listing shows an example for a Station List File:

<?xml version = "1.0" encoding = "UTF-8"?>
<Earth_Explorer_File>

<Earth_Explorer_Header>
<Fixed_Header>
<File_Name>C:\mystationlist.slf</File_Name>
<File_Description>Stations List File</File_Description>
<Notes></Notes>
<Mission></Mission>
<File_Class></File_Class>
<File_Type></File_Type>
<Validity_Period>

<Validity_Start></Validity_Start>
<Validity_Stop></Validity_Stop>

</Validity_Period>
<File_Version>1.0</File_Version>
<Source>

<System></System>
<Creator></Creator>
<Creator_Version></Creator_Version>
<Creation_Date></Creation_Date>

</Source>
</Fixed_Header>
<Variable_Header></Variable_Header>

</Earth_Explorer_Header>
<Appearance>
<Station_Opacity>100</Station_Opacity>
<Station_Color>FF00FF</Station_Color>
<Station_Style>CIRCULAR</Station_Style>
<Station_Symbol_Size>7</Station_Symbol_Size>
<Perimeter_Opacity>100</Perimeter_Opacity>
<Perimeter_Color>FFC800</Perimeter_Color>
<Perimeter_Style>SOLID</Perimeter_Style>

</Appearance>
<List_of_Stations count="1">
<Station>
<Name>GHYDERHX</Name>

<Definition_Type>USER_DEFINED</Definition_Type>
<List_of_Spacecrafts count="1">

<Spacecraft>
<Name>ADM</Name>
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<Entry_El>20.0</Entry_El>
<Exit_El>10.0</Exit_El>
<Phys_Mask>MASK_ONLY</Phys_Mask>

</Spacecraft>
</List_of_Spacecrafts>

</Station>
</List_of_Stations>

</Earth_Explorer_File>

19.3.12 LLF File

The following listing shows an example for an LLF File (snippet) in XML format:

<?xml version = "1.0" encoding = "UTF-8"?>
<Earth_Explorer_File xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance" xsi: ←↩

schemaLocation="http://eop-cfi.esa.int/esov http://eop-cfi.esa.int/esov/ ←↩
ESOVNG_SCHEMAS/EO_ESOVNG_LLF_0100.XSD" xmlns="http://eop-cfi.esa.int/esov" ←↩
schemaVersion="1.0">

<Earth_Explorer_Header>
<Fixed_Header>
<File_Name>ALADIN.llf</File_Name>
<File_Description>LLF File</File_Description>
<Notes>...</Notes>
<Mission>AEOLUS</Mission>
<File_Class>TEST</File_Class>
<File_Type>ESOVNG_LLF</File_Type>
<Validity_Period>
<Validity_Start>UTC=2000-01-01T18:00:02</Validity_Start>
<Validity_Stop>UTC=2000-01-01T21:04:59</Validity_Stop>

</Validity_Period>
<File_Version>0001</File_Version>
<Source>
<System>Esov</System>
<Creator>Esov</Creator>
<Creator_Version>2.2</Creator_Version>
<Creation_Date>UTC=2015-04-17T19:02:17</Creation_Date>

</Source>
</Fixed_Header>
<Variable_Header>
<Init_Def_Data>
<Orbit>

<Absolute_Orbit>1</Absolute_Orbit>
</Orbit>
<Cycle>

<Repeat_Cycle unit="day">7</Repeat_Cycle>
<Cycle_Length unit="orbit">109</Cycle_Length>
<ANX_Longitude unit="deg">0.0</ANX_Longitude>
<MLST unit="h">18.0</MLST>
<MLST_Drift unit="s/day">0.0</MLST_Drift>
<Date>2000-01-01T18:00:02</Date>

</Cycle>
</Init_Def_Data>

</Variable_Header>
</Earth_Explorer_Header>
<Data_Block type="xml">

<Llf>
<Instrument>ALADIN</Instrument>
<List_of_Segments count="1">
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<Segment>
<Start>
<Absolute_Orbit>1</Absolute_Orbit>
<Time_From_ANX unit="s">0.000000</Time_From_ANX>
<UTC>2000-01-01T18:00:02.123636</UTC>
<List_of_Swath_Pts count="3">
<Swath_Pt>
<Long unit="deg">2.286361</Long>
<Lat unit="deg">0.427925</Lat>

</Swath_Pt>
<Swath_Pt>
<Long unit="deg">2.387212</Long>
<Lat unit="deg">0.446796</Lat>

</Swath_Pt>
<Swath_Pt>
<Long unit="deg">2.488678</Long>
<Lat unit="deg">0.465782</Lat>

</Swath_Pt>
</List_of_Swath_Pts>

</Start>
<Stop>
<Absolute_Orbit>2</Absolute_Orbit>
<Time_From_ANX unit="s">5548.623853</Time_From_ANX>
<UTC>2000-01-01T21:04:59.371342</UTC>
<List_of_Swath_Pts count="3">
<Swath_Pt>
<Long unit="deg">-43.952172</Long>
<Lat unit="deg">0.427925</Lat>

</Swath_Pt>
<Swath_Pt>
<Long unit="deg">-43.851320</Long>
<Lat unit="deg">0.446796</Lat>

</Swath_Pt>
<Swath_Pt>
<Long unit="deg">-43.749855</Long>
<Lat unit="deg">0.465782</Lat>

</Swath_Pt>
</List_of_Swath_Pts>

</Stop>
<Station></Station>

<Zone>GHAWAIHX</Zone>
<GEO></GEO>

<Time_Step unit="s">11097.247706</Time_Step>
<List_of_Points count="2">
<Point index="0">
<Absolute_Orbit>1</Absolute_Orbit>
<Time_From_ANX unit="s">0.000000</Time_From_ANX>
<UTC>2000-01-01T18:00:02.123636</UTC>
<List_of_Swath_Pts count="3">
<Swath_Pt>

<Long unit="deg">2.286361</Long>
<Lat unit="deg">0.427925</Lat>

</Swath_Pt>
<Swath_Pt>

<Long unit="deg">2.387212</Long>
<Lat unit="deg">0.446796</Lat>

</Swath_Pt>
<Swath_Pt>

<Long unit="deg">2.488678</Long>
<Lat unit="deg">0.465782</Lat>

</Swath_Pt>
</List_of_Swath_Pts>
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</Point>
<Point index="1">
<Absolute_Orbit>2</Absolute_Orbit>
<Time_From_ANX unit="s">5548.623853</Time_From_ANX>
<UTC>2000-01-01T21:04:59.371342</UTC>
<List_of_Swath_Pts count="3">
<Swath_Pt>

<Long unit="deg">-43.952172</Long>
<Lat unit="deg">0.427925</Lat>

</Swath_Pt>
<Swath_Pt>

<Long unit="deg">-43.851320</Long>
<Lat unit="deg">0.446796</Lat>

</Swath_Pt>
<Swath_Pt>

<Long unit="deg">-43.749855</Long>
<Lat unit="deg">0.465782</Lat>

</Swath_Pt>
</List_of_Swath_Pts>

</Point>
</List_of_Points>

</Segment>
</List_of_Segments>

</Llf>
</Data_Block>

</Earth_Explorer_File>

The following listing shows an example for an LLF File in CSV format:

Earth_Explorer_Header

Fixed_Header
File_Name;OLCI.llf
File_Description;LLF File
Notes;...
Mission;SENTINEL3
File_Class;TEST
File_Type;LLF
File_Version;0002
Validity_Period
Validity_Start;2000-01-01;22:00:03
Validity_Stop;2000-01-01;23:41:02
Source
System;Esov
Creator;Esov
Creator_Version;1.5
Creation_Date;UTC=2009-06-17;10:52:09

Variable_Header
Orbit
Absolute_Orbit;1
Cycle
Repeat_Cycle;27;unit="day"
Cycle_Length;385;unit="orbit"
ANX_Longitude;0.0;unit="deg"
MLST;22.0;unit="h"
MLST_Drift;0.0;unit="s/day"
Date;2000-01-01;22:00:03

Instrument;OLCI
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Segment
Index;Absolute_Orbit;Time_From_ANX;yyyy-mm-dd;hh:mm:ss.sss;Lon;Lat;Lon;Lat; ←↩

Lon;Lat;Zone;Station;Geo
0;1;49.952856;2000-01-01;22:00:52.544;-3.552418;2.322534;-0.654124;2.952541; ←↩

7.450526;4.664833;;;23.8
1;1;79.952856;2000-01-01;22:01:22.544;-3.950477;4.093101;-1.047972;4.725755; ←↩

7.078453;6.421151;;;23.8
2;1;109.952856;2000-01-01;22:01:52.544;-4.352770;5.863304;-1.443202;6.498882; ←↩

6.713059;8.178037;;;23.8
3;1;139.952856;2000-01-01;22:02:22.544;-4.759856;7.633050;-1.840341;8.271840; ←↩

6.353968;9.935392;;;23.8
4;1;169.952856;2000-01-01;22:02:52.544;-5.172320;9.402243;-2.239930;10.044549; ←↩

6.000827;11.693121;;;23.8
5;1;199.952856;2000-01-01;22:03:22.544;-5.590780;11.170784;-2.642529;11.816924; ←↩

5.653304;13.451135;;;23.8
6;1;229.952856;2000-01-01;22:03:52.544;-6.015891;12.938570;-3.048723;13.588881; ←↩

5.311086;15.209347;;;23.8
7;1;259.952856;2000-01-01;22:04:22.544;-6.448351;14.705494;-3.459124;15.360336; ←↩

4.973877;16.967676;;;23.8
8;1;289.952856;2000-01-01;22:04:52.544;-6.888907;16.471445;-3.874379;17.131200; ←↩

4.641397;18.726044;;;23.8
9;1;319.952856;2000-01-01;22:05:22.544;-7.338364;18.236307;-4.295177;18.901386; ←↩

4.313379;20.484377;;;23.8
10;1;349.952856;2000-01-01;22:05:52.544;-7.797591;19.999956;-4.722251;20.670803; ←↩

3.989569;22.242608;;;23.8
11;1;379.952856;2000-01-01;22:06:22.544;-8.267531;21.762266;-5.156391;22.439357; ←↩

3.669725;24.000669;;;23.8
12;1;409.952856;2000-01-01;22:06:52.544;-8.749212;23.523098;-5.598452;24.206951; ←↩

3.353615;25.758500;;;23.8
13;1;439.952856;2000-01-01;22:07:22.544;-9.243760;25.282308;-6.049361;25.973486; ←↩

3.041015;27.516044;;;23.8
14;1;469.952856;2000-01-01;22:07:52.544;-9.752409;27.039742;-6.510131;27.738855; ←↩

2.731711;29.273247;;;23.8
15;1;499.952856;2000-01-01;22:08:22.544;-10.276521;28.795232;-6.981869;29.502948; ←↩

2.425514;31.030060;;;23.8
16;1;529.952856;2000-01-01;22:08:52.544;-10.817605;30.548598;-7.465807;31.265648; ←↩

2.122198;32.786438;;;23.8
17;1;559.952856;2000-01-01;22:09:22.544;-11.377336;32.299643;-7.963306;33.026829; ←↩

1.821563;34.542339;;;23.8
18;1;586.073893;2000-01-01;22:09:48.665;-11.881336;33.822225;-8.408714;34.558948; ←↩

1.561792;36.070787;;;23.8
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The following listing shows an example for an LLF File in ASCII format:

# Earth_Explorer_Header
# File_Name: OLCI.llf
# File_Description: LLF File
# Mission: SENTINEL3
# File_Class: TEST
# File_Type: LLF
# Validity_Start: 2000-01-01T22:00:03
# Validity_Stop: 2000-01-01T23:41:02
# File_Version: 0002
# System: Esov
# Creator: Esov
# Creator_Version: 1.5
# Creation_Date: UTC=2009-06-17T10:52:27
# Absolute_Orbit: 1
# Repeat_Cycle: 27 [days]
# Cycle_Length: 385 [orbits]
# ANX_Longitude: 0.000000 [deg]
# MLST: 22.0 [h]
# MLST_Drift: 0.0 [s/day]
# Date: 2000-01-01T22:00:03
# End Earth_Explorer_Header
# Data_Block
# Instrument: OLCI
# 1 Number of visibility segments | Number of points per instantaneous ←↩

swath
1 3
# 2 Index of visibility segment | Orbit number start | Seconds since ANX ←↩

start | UTC time start | {Longitude [deg] Latitude [deg],..} | Orbit ←↩
number stop | Seconds since ANX stop | UTC time stop | {Longitude [deg ←↩
] Latitude [deg],...} | Zone | Station | Geo

0 1 +49.952856 20000101_220052544131 -003.552418 +002.322534 -000.654124 ←↩
+002.952541 +007.450526 +004.664833 1 +586.073893 20000101_220948665168 ←↩
-011.881336 +033.822225 -008.408714 +034.558948 +001.561792 +036.070787 ←↩
23.8

# 3 Time step [s] | Number of intermediate points in visibility segment
+030.000000 19
# 4 Index of intermediate point | Orbit number | Seconds since ANX | UTC ←↩

time | {Longitude [deg] Latitude [deg],..}
0 1 +49.952856 20000101_220052544131 -003.552418 +002.322534 -000.654124 ←↩

+002.952541 +007.450526 +004.664833
1 1 +79.952856 20000101_220122544131 -003.950477 +004.093101 -001.047972 ←↩

+004.725755 +007.078453 +006.421151
2 1 +109.952856 20000101_220152544131 -004.352770 +005.863304 -001.443202 ←↩

+006.498882 +006.713059 +008.178037
3 1 +139.952856 20000101_220222544131 -004.759856 +007.633050 -001.840341 ←↩

+008.271840 +006.353968 +009.935392
4 1 +169.952856 20000101_220252544131 -005.172320 +009.402243 -002.239930 ←↩

+010.044549 +006.000827 +011.693121
5 1 +199.952856 20000101_220322544131 -005.590780 +011.170784 -002.642529 ←↩

+011.816924 +005.653304 +013.451135
6 1 +229.952856 20000101_220352544131 -006.015891 +012.938570 -003.048723 ←↩

+013.588881 +005.311086 +015.209347
7 1 +259.952856 20000101_220422544131 -006.448351 +014.705494 -003.459124 ←↩

+015.360336 +004.973877 +016.967676
8 1 +289.952856 20000101_220452544131 -006.888907 +016.471445 -003.874379 ←↩

+017.131200 +004.641397 +018.726044
9 1 +319.952856 20000101_220522544131 -007.338364 +018.236307 -004.295177 ←↩
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+018.901386 +004.313379 +020.484377
10 1 +349.952856 20000101_220552544131 -007.797591 +019.999956 -004.722251 ←↩

+020.670803 +003.989569 +022.242608
11 1 +379.952856 20000101_220622544131 -008.267531 +021.762266 -005.156391 ←↩

+022.439357 +003.669725 +024.000669
12 1 +409.952856 20000101_220652544131 -008.749212 +023.523098 -005.598452 ←↩

+024.206951 +003.353615 +025.758500
13 1 +439.952856 20000101_220722544131 -009.243760 +025.282308 -006.049361 ←↩

+025.973486 +003.041015 +027.516044
14 1 +469.952856 20000101_220752544131 -009.752409 +027.039742 -006.510131 ←↩

+027.738855 +002.731711 +029.273247
15 1 +499.952856 20000101_220822544131 -010.276521 +028.795232 -006.981869 ←↩

+029.502948 +002.425514 +031.030060
16 1 +529.952856 20000101_220852544131 -010.817605 +030.548598 -007.465807 ←↩

+031.265648 +002.122198 +032.786438
17 1 +559.952856 20000101_220922544131 -011.377336 +032.299643 -007.963306 ←↩

+033.026829 +001.821563 +034.542339
18 1 +586.073893 20000101_220948665168 -011.881336 +033.822225 -008.408714 ←↩

+034.558948 +001.561792 +036.070787
# End Data_Block

19.3.13 UTF File

The following listing shows an example for an UTF File in XML format:

<?xml version = "1.0" encoding = "UTF-8"?>
<Earth_Explorer_File xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance" xsi: ←↩

schemaLocation="http://eop-cfi.esa.int/esov http://eop-cfi.esa.int/esov/ ←↩
ESOVNG_SCHEMAS/EO_ESOVNG_UTF_0100.XSD" xmlns="http://eop-cfi.esa.int/esov" ←↩
schemaVersion="1.0">

<Earth_Explorer_Header>
<Fixed_Header>
<File_Name>ALADIN.utf</File_Name>
<File_Description>UTF File</File_Description>
<Notes>...</Notes>
<Mission>AEOLUS</Mission>
<File_Class>TEST</File_Class>
<File_Type>ESOVNG_UTF</File_Type>
<Validity_Period>
<Validity_Start>UTC=2000-01-01T18:00:02</Validity_Start>
<Validity_Stop>UTC=2000-01-01T21:04:59</Validity_Stop>

</Validity_Period>
<File_Version>0001</File_Version>
<Source>
<System>Esov</System>
<Creator>Esov</Creator>
<Creator_Version>2.2</Creator_Version>
<Creation_Date>UTC=2015-04-17T19:02:22</Creation_Date>

</Source>
</Fixed_Header>
<Variable_Header>
<Init_Def_Data>
<Orbit>

<Absolute_Orbit>1</Absolute_Orbit>
</Orbit>
<Cycle>

<Repeat_Cycle unit="day">7</Repeat_Cycle>
<Cycle_Length unit="orbit">109</Cycle_Length>
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<ANX_Longitude unit="deg">0.0</ANX_Longitude>
<MLST unit="h">18.0</MLST>
<MLST_Drift unit="s/day">0.0</MLST_Drift>
<Date>2000-01-01T18:00:02</Date>

</Cycle>
</Init_Def_Data>

</Variable_Header>
</Earth_Explorer_Header>
<Data_Block type="xml">

<Utf>
<Instrument>ALADIN</Instrument>
<List_of_Segments count="1">
<Segment>

<Start>
<Absolute_Orbit>1</Absolute_Orbit>
<Time_From_ANX unit="s">0.000000</Time_From_ANX>
<UTC>2000-01-01T18:00:02.123636</UTC>

</Start>
<Stop>
<Absolute_Orbit>2</Absolute_Orbit>
<Time_From_ANX unit="s">5548.623853</Time_From_ANX>
<UTC>2000-01-01T21:04:59.371342</UTC>

</Stop>
<Station></Station>

<Zone>GHAWAIHX</Zone>
<GEO></GEO>
</Segment>

</List_of_Segments>
</Utf>

</Data_Block>
</Earth_Explorer_File>

The following listing shows an example for an UTF File in CSV format:

Earth_Explorer_Header

Fixed_Header
File_Name;OLCI.utf
File_Description;UTF File
Notes;...
Mission;SENTINEL3
File_Class;TEST
File_Type;UTF
File_Version;0001
Validity_Period
Validity_Start;2000-01-01;22:00:03
Validity_Stop;2000-01-01;23:41:02
Source
System;Esov
Creator;Esov
Creator_Version;1.5
Creation_Date;UTC=2009-06-17;10:53:26

Variable_Header
Orbit
Absolute_Orbit;1
Cycle
Repeat_Cycle;27;unit="day"
Cycle_Length;385;unit="orbit"
ANX_Longitude;0.0;unit="deg"
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MLST;22.0;unit="h"
MLST_Drift;0.0;unit="s/day"
Date;2000-01-01;22:00:03

Instrument;OLCI

Segment
Name;Absolute_Orbit;Time_From_ANX;yyyy-mm-dd;hh:mm:ss.sss;Zone;Station; ←↩

Geo
Start;1;49.952856;2000-01-01;22:00:52.544;;;23.8
Stop;1;586.073893;2000-01-01;22:09:48.665;;;23.8

The following listing shows an example for an UTF File in ASCII format:

# Earth_Explorer_Header
# File_Name: OLCI.utf
# File_Description: UTF File
# Mission: SENTINEL3
# File_Class: TEST
# File_Type: UTF
# Validity_Start: 2000-01-01T22:00:03
# Validity_Stop: 2000-01-01T23:41:02
# File_Version: 0001
# System: Esov
# Creator: Esov
# Creator_Version: 1.5
# Creation_Date: UTC=2009-06-17T10:53:31
# Absolute_Orbit: 1
# Repeat_Cycle: 27 [days]
# Cycle_Length: 385 [orbits]
# ANX_Longitude: 0.000000 [deg]
# MLST: 22.0 [h]
# MLST_Drift: 0.0 [s/day]
# Date: 2000-01-01T22:00:03
# End Earth_Explorer_Header
# Data_Block
# Instrument: OLCI
# 101 Number of visibility segments
1
# 102 Index of visibility segment | Orbit number start | Seconds since ←↩

ANX start | UTC time start
| Orbit number stop | Seconds since ANX stop | UTC time stop| Zone | ←↩

Station | Geo
0 1 +049.952856 20000101_220052544131 1 +586.073893 20000101 ←↩

_220948665168 23.8
# End Data_Block

19.4 Software used in ESOV-NG

This is a list of the most important 3rd party software used in ESOV-NG.

• Java Runtime environment, versions Java8, ORACLE free license

• JAI (Java Advanced Imaging), version 1.1.3, SUN free license

• JIDE Docking Framework Technology, version 3.6.7, JIDE commercial license, purchased by ESA
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• Geotools Library, version 22.0, GNU General Public License

• Earth Observation CFI, version 4.14, ESA license

• JFreeChart, version 1.5.0, GNU Lesser General Public Licence

• Install4J, version 5.1.15 (frequently updated), EJ Technologies commercial license, purchased by ESA

• XStream, version 1.4.11.1, BSD free license

• XPP3, version 1.1.6, Apache free license

• Docbook, version 1.73.2, GNU free license

• JUnit, version 4.12, CPL (common public license)

• Apache Maven, version 3.1.1, Apache free license

• iText, version 5.5.13.1, AGPL free license

• JCommon, version 1.0.24, GNU free license

• CommonsLang3, version 3.9, Apache free license

• Orekit, version 10.0, Apache free license

• javahelp, version 2.0.05, Apache free license

• Ceres, version 0.9.2-SNAPSHOT, GNU free license

• i4jruntime, version 5.1.5, GNU free license

• Jai, version 1.1.3, JDL free license

• Jai_imageio, version 1.1.1, BSD free license

• commons-math3, version 3.6.1, Apache free license
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